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Inhalt dieses Handbuchs…
Dieses Handbuch enthält Informationen, die Sie kennen müssen, um Agilent 
MassHunter Workstation Software - Qualitative Analyse mit GC/MS-Daten 
einsetzen zu können. 

Bitte lesen Sie vor Beginn der Übungen die Anweisungen in „Bevor Sie mit 
diesen Übungen beginnen...“ auf Seite 5.

Übung 1 Lerngrundlagen der qualitativen Analyse

In dieser Übung lernen Sie einige der vielen leistungsfähigen Funktionen des 
Programms zur qualitativen Analyse kennen. Diese Aufgaben sind wichtig, 
unabhängig vom Datentyp, den Sie benutzen.

Übung 2 Finden und identifizieren

In den ersten beiden Aufgabenbereichen finden und identifizieren Sie niedrig 
konzentrierte Sulfonamide innerhalb einer komplexen Matrix und generieren 
ihre Formeln sowohl für TOF- als auch für Q-TOF-Daten. Außerdem führen Sie 
eine Erkennung von molekularen Merkmalen an einem Proteinauszug sowohl 
mit TOF- als auch mit Q-TOF-Daten aus. Diese Aufgaben können auch an 
Triple Quad-Daten durchgeführt werden.

Übung 3 Verwenden von Workflows, Exportieren und Drucken

Im Rahmen dieser Aufgaben lernen Sie, wie Sie eine qualitative 
Analysemethode einrichten und ausführen. Außerdem erfahren Sie, wie eine 
Methode so bearbeitet wird, dass die Analyse und/oder 
Verbindungsidentifikation automatisch abläuft. Anschließend führen Sie die 
Aktionen innerhalb der automatisierten Methode beim Öffnen einer 
Datendatei aus. Es wird erklärt, wie eine Methode zum Durchführen 
automatisierter Aktionen anhand einer Arbeitsliste erstellt wird. Jede dieser 
Aufgaben wird mit einem anderen Arbeitsablauf durchgeführt.

Referenz

In diesem Kapitel lernen Sie einige Grundlagen des Programms zur 
qualitativen Analyse kennen.
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Neu

in B.06.00

• In der Compound Details View können Sie Verbindungen überprüfen. Vier 
weitere Fenster sind in der Compound Details View verfügbar.

• Für die Compound Details View können Sie verschiedene 
Liniendefinitionen für verschiedene Typen von Chromatogrammen und 
Spektren festlegen.

• Der Find Compounds by Integration-Algorithmus ist verfügbar.

• Sie können mehrere Bibliotheken mit dem 
Masseneinheiten-Bibliothekensuchalgorithmus durchsuchen.

• Im Algorithmus Generate Formulas können Sie auswählen, ob Sie Formeln 
zu Fragmentspektrum-Peaks anmerken möchten. Bei der 
Fragmentanmerkung werden Spektren, die mit Anmerkungen versehen 
werden, nach einem Algorithmus zum Finden von Verbindungen 
ausgewählt.

• Der Algorithmus Generate Formulas kann für Verbindungen ausgeführt 
werden, die Sie mit dem Algorithmus Find by Chromatogram 
Deconvolution gefunden haben.

• Der Algorithmus Generate Formulas wurde so geändert, dass Sie für jeden 
Ladungsträger eine Maximalzahl von Treffern eingeben können.

• Im Algorithmus Generate Formulas können Sie Treffer mit derselben 
Formel, aber verschiedenen Ladungsträgern gruppieren.

• Verbindungen können aus einem beliebigen Benutzerspektrum erstellt 
werden. Der Algorithmus zum Finden von Verbindungen für diese 
Verbindungen ist Spectrum Extraction.

• Wenn Sie Ergebnisse in einer Datendatei speichern, können Sie wählen, ob 
alle Verbindungsergebnisse in einer Datendatei oder eine kleinere Gruppe 
von Ergebnissen für jede Verbindung gespeichert werden soll. Alle 
Benutzerchromatogramme und Benutzerspektren werden stets 
gespeichert.

• Das Format der CEF-Datei wurde geändert, sodass mehr Informationen 
einbezogen werden.

• Die m/z- und Ionenarteninformationen sind auf der ersten Ebene der 
Spectrum Identification Results-Tabelle verfügbar.
4 Agilent MassHunter Workstation Software - Handbuch zur Einarbeitung in die qualitative Analyse für GC/MS



• Die Spectrum Identification-Tabelle wurde geändert. Sie können einer 
Säule einen Filter hinzufügen und eine Zeile löschen.

• Sie können einen Peak jetzt mit Formula & Ion Species beschriften.

• Bei einer großen Zahl von Einträgen können Sie jetzt das im Fenster 
Spectrum Identification Results mit Best bezeichnete Spektrum bedeutend 
schneller ändern.

• Im Compound Report können Sie festlegen, dass 
Verbindungschromatogramme überlagert werden.

• Die Standardreportvorlage zur Formelbestätigung wurde geändert, sodass 
sie jetzt die farbige Spalte Flags (Tgt) und die Fragmenttabelle mit der 
farbigen Spalte Flags (FIs) enthält.

Bevor Sie mit diesen Übungen beginnen...
• Installieren Sie die Software. Beachten Sie die Anweisungen im 

Installationshandbuch.

• Kopieren Sie den Ordner Data in unkomprimiertem Format an einen 
beliebigen Speicherort auf Ihrer Festplatte. 

Dieser Ordner enthält alle für diese Übungen benötigten Datendateien. 
Zunächst müssen Sie die Datendateien aus dem ZIP-Format extrahieren.

HINWEIS Sie dürfen die bereits auf Ihrem System befindlichen Beispieldatendateien nur dann 
wiederverwenden, wenn Sie sicher sind, dass Sie sie von den Originalen auf dem 
Datenträger kopiert haben und Sie der einzige sind, der sie benutzt. Wenn die bereits auf 
dem System befindlichen Beispieldatendateien nicht exakt den Originalen auf dem 
Datenträger entsprechen, entsprechen die während dieser Übungen erzielten Ergebnisse 
nicht den im Handbuch dargestellten.
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Agilent MassHunter Workstation Software Qualitative Analyse
Einarbeitungshandbuch
1
Lerngrundlagen der qualitativen 
Analyse

Aufgabe 1. Aufruf des Programms zur qualitativen Analyse 10

Aufgabe 2. Benutzeroberfläche für GC/MS-Daten konfigurieren 12

Aufgabe 3. In das Chromatogramm hinein- und daraus herauszoomen 16

Aufgabe 4. Ein Chromatogramm verankern 17

Aufgabe 5. Fensterlayouts ändern 19

Aufgabe 6. Chromatogramme extrahieren 21

Aufgabe 7. Ein GC/MS-Chromatogramm interaktiv integrieren 23

Aufgabe 8. Systemeignungswerte berechnen 28

Aufgabe 9. Spektren aus einem Chromatogramm extrahieren 32

Aufgabe 10. Anmerkungen hinzufügen 43

Aufgabe 11. Massenmessschieber hinzufügen 48

In dieser Übung lernen Sie einige der vielen leistungsfähigen Funktionen des 
Programms zur qualitativen Analyse zum Arbeiten mit GC/Q-TOF- und 
GC/QQQ-Daten kennen.

Jede Übung wird in einer dreispaltigen Tabelle dargestellt:

• Schritte – lernen Sie das Programm mit diesen allgemeinen Anweisungen 
selbstständig kennen.

• Ausführliche Anweisungen – benutzen Sie sie, wenn Sie Hilfe benötigen 
oder einen schrittweisen Lernprozess bevorzugen.

• Anmerkungen – lesen Sie sie, um Tipps und weitere Informationen zu den 
einzelnen Schritten der Übung zu erfahren.
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1 Lerngrundlagen der qualitativen Analyse
Aufgabe 1. Aufruf des Programms zur qualitativen Analyse
Aufgabe 1. Aufruf des Programms zur qualitativen Analyse

In dieser Aufgabe öffnen Sie mehrere Datendateien mit der gängigen Methode. 

 

Aufgabe 1. Aufruf des Programms zur qualitativen Analyse mit mehreren Datendateien 

Schritte Ausführliche Anweisungen Anmerkungen

1 Rufen Sie das Programm zur 
qualitativen Analyse auf. 
• Öffnen Sie die Datendateien 

Pest - 200 - Scan.d, Pest - STD 
200 MRM.d, Pest Strawb-01 
SPIKED 1 ppb - 1 ul inj.d und 
MSD_mix_4stds_DG_spl200_0
3.d im Ordner 
\\MassHunter\Data bzw. in 
dem Ordner, in den Sie sie 
kopiert haben.

a Doppelklicken Sie auf das Symbol 
Agilent MassHunter Qualitative 
Analysis B.06.00 . 
Das System zeigt das Dialogfeld Open 
Data Files an.

b Wechseln Sie zum Ordner 
\\MassHunter\Data\GC bzw. dem 
Ordner, in dem die Beispieldateien 
gespeichert sind.

• Die Datei Pest - 200 - Scan.d enthält 
MS-Daten und die Dateien Pest - 
STD 200 MRM.d und Pest 
Strawb-01 SPIKED 1 ppb - 1 ul inj.d 
enthalten sowohl MS- als auch 
MS/MS-Daten (alle GC/QQQ). 
MSD_mix_4stds_DG_spl200_03.d 
enthält GC/Q-TOF-Daten.

• Zu den meisten Fenstern, 
Dialogfeldern und Registerkarten 
erhalten Sie Hilfe, wenn Sie F1 
drücken, während das Fenster aktiv 
ist.

• Achten Sie darauf, dass die 
Schaltfläche Use current 
method aktiviert ist.

• Achten Sie darauf, dass das 
Kontrollkästchen Load result 
data nicht aktiviert ist. Wenn das 
Kontrollkästchen Load result 
data nicht verfügbar ist, wurden 
keine Ergebnisse in der 
Datendatei gespeichert. In 
„Aufgabe 17. Ergebnisse 
speichern“ auf Seite 74 lernen 
Sie, wie Sie Ergebnisse 
speichern.

• Achten Sie darauf, dass das 
Kontrollkästchen Run ‘File 
Open’ actions from selected 
method nicht aktiviert ist.

Abb. 1 Öffnen von Datendateien beim Aufruf der Software
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Lerngrundlagen der qualitativen Analyse 1
Aufgabe 1. Aufruf des Programms zur qualitativen Analyse
c Halten Sie die Umschalt-Taste 
gedrückt, während Sie auf Pest - 200 - 
Scan.d, Pest - STD 200 MRM.d, Pest 
Strawb-01 SPIKED 1 ppb - 1 ul inj.d 
und 
MSD_mix_4stds_DB_spl200_03.d 
klicken.

d Klicken Sie auf Open.
Alle vier Datendateien werden im 
Fenster Data Navigator angezeigt, und 
im Fenster Chromatogram Results 
werden die Chromatogramme 1 bis 
3 angezeigt.

e Klicken Sie in der Symbolleiste 
Chromatogram Results 
auf das Symbol List Mode .

• Wenn Sie die Strg-Taste drücken, 
können Sie Dateien auswählen, die 
sich nicht direkt nebeneinander in 
der Liste befinden.

• Was Sie an diesem Punkt im 
Hauptfenster sehen, hängt davon 
ab, welche Methode, welches 
Layout, welche Anzeige- und 
Ploteinstellungen Sie vor Öffnen 
dieser Dateien verwendet haben.

• Wenn Sie auf das Symbol List Mode 
klicken, wird der Hintergrund des 
Symbols orange. 

Aufgabe 1. Aufruf des Programms zur qualitativen Analyse mit mehreren Datendateien  (Fortsetzung)

Schritte Ausführliche Anweisungen Anmerkungen
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1 Lerngrundlagen der qualitativen Analyse
Aufgabe 2. Benutzeroberfläche für GC/MS-Daten konfigurieren
Aufgabe 2. Benutzeroberfläche für GC/MS-Daten konfigurieren

In dieser Aufgabe wechseln Sie entweder zum allgemeinen Arbeitsablauf 
(GC/QQQ-Kunden) oder dem GC/Q-TOF Compound Screening-Arbeitsablauf 
(GC/Q-TOF-Kunden). Diese beiden Arbeitsabläufe sind die einzigen, die die 
Analyse von GC/MS-Daten unterstützen. Dann öffnen Sie das Dialogfeld User 
Interface Configuration und markieren die entsprechenden Kontrollkästchen 
für ein GC/QQQ- oder GC/Q-TOF-System.

Abb. 2 Hauptfenster der qualitativen Analyse mit geladenem GC/Q-TOF Compound 
Screening-Arbeitsablauf. 

Aufgabe 1. Aufruf des Programms zur qualitativen Analyse mit mehreren Datendateien  (Fortsetzung)

Schritte Ausführliche Anweisungen Anmerkungen

Symbol Maximum 
Number of List Panes

Symbol Display 
Options

Mit Klicken auf Taste X 
schließen Sie dieses 
Fenster.
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Lerngrundlagen der qualitativen Analyse 1
Aufgabe 2. Benutzeroberfläche für GC/MS-Daten konfigurieren
Aufgabe 2. Benutzeroberfläche für GC konfigurieren

Schritte Ausführliche Anweisungen Anmerkungen

1 Rufen Sie ggf. das Programm zur 
qualitativen Analyse auf. 

a Doppelklicken Sie auf das Symbol 
Agilent MassHunter Qualitative 
Analysis . 
Das System zeigt das Dialogfeld Open 
Data Files an.

b Klicken Sie im Dialogfeld Open Data 
Files auf Cancel.

• Zu beliebigen Fenstern, 
Dialogfeldern und Registerkarten 
erhalten Sie Hilfe, wenn Sie F1 
drücken, während das Fenster aktiv 
ist.

2 Wechseln Sie entweder zum 
allgemeinen Arbeitsablauf oder 
dem GC/Q-TOF Compound 
Screening-Arbeitsablauf.

a Wenn Sie ein GC/QQQ-Gerät haben, 
klicken Sie auf den Befehl 
Configuration > Configure for 
Workflow > General. Wenn Sie ein 
GC/Q-TOF-Gerät haben, klicken Sie auf 
den Befehl Configuration > Configure 
for Workflow > GC/Q-TOF Compound 
Screening.

b Klicken Sie auf die Schaltflächen Load 
workflow’s default method und Load 
workflow’s default layout.

c Klicken Sie auf OK.
d Klicken Sie in der Symbolleiste 

Chromatogram Results 
auf das Symbol List Mode .

• Wenn das Data 
Acquisition-Programm für GC/QQQ 
oder GC/Q-TOF auf demselben 
Computer installiert ist, konfiguriert 
die Software die 
Benutzeroberfläche automatisch. 
Der GC/Q-TOF Compound 
Screening-Abschnitt könnte bereits 
im Method Explorer-Fenster 
verfügbar sein.

• Standardmäßig werden 
Chromatogramme überlagert. Für 
diese Beispiele werden die 
Chromatogramme im List Mode 
angezeigt.
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1 Lerngrundlagen der qualitativen Analyse
Aufgabe 2. Benutzeroberfläche für GC/MS-Daten konfigurieren
3 Wenn Sie einen GC/QQQ haben, 
konfigurieren Sie die 
Benutzeroberfläche so, dass nur 
GC/QQQ-Funktionen angezeigt 
werden.

a Klicken Sie auf Configuration > User 
Interface Configuration.

b Markieren Sie unter Separation types 
nur das Kontrollkästchen GC.

c Wenn Sie ein GC/QQQ-Gerät haben, 
markieren Sie unter Ionization type das 
Kontrollkästchen EI or other „hard“ 
ionization technique und deaktivieren 
Sie das Kontrollkästchen CI, APCI, ESI, 
MADLDI or other „soft“ ionization 
technique.

d Deaktivieren Sie unter Mass accuracy 
das Kontrollkästchen Accurate mass 
(TOF, Q-TOF). Markieren Sie das 
Kontrollkästchen Unit mass (Q, QQQ).

e Deaktivieren Sie unter Optional 
software features die Kontrollkästchen 
Peptide Sequence Editor und 
BioConfirm Software.

f Deaktivieren Sie unter Non-MS 
detectors die Kontrollkästchen UV und 
ADC.

g Markieren Sie das Kontrollkästchen 
Show advanced parameters.

h Klicken Sie auf OK.

• Im Dialogfeld User Interface 
Configuration legen Sie fest, 
welche Befehle verfügbar sind. 

• Wenn eine Funktion nicht sichtbar 
ist, wurde sie vielleicht 
ausgeblendet, als ein 
Kontrollkästchen im Dialogfeld User 
Interface Configuration deaktiviert 
wurde.

Abb. 3 Konfigurieren der Benutzeroberfläche zum Einsatz mit GC/QQQ-Daten

Aufgabe 2. Benutzeroberfläche für GC konfigurieren

Schritte Ausführliche Anweisungen Anmerkungen
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Lerngrundlagen der qualitativen Analyse 1
Aufgabe 2. Benutzeroberfläche für GC/MS-Daten konfigurieren
4 Wenn Sie ein GC/Q-TOF-Gerät 
haben, konfigurieren Sie die 
Benutzeroberfläche so, dass nur 
GC/Q-TOF-Funktionen angezeigt 
werden.

a Klicken Sie auf Configuration > User 
Interface Configuration.

b Markieren Sie unter Separation types 
nur das Kontrollkästchen GC.

c Markieren Sie unter Ionization type 
beide Kontrollkästchen.

d Markieren Sie unter MS levels beide 
Kontrollkästchen.

e Markieren Sie unter Mass accuracy 
das Kontrollkästchen Accurate mass 
(TOF, Q-TOF). Deaktivieren Sie das 
Kontrollkästchen Unit mass (Q, QQQ).

f Deaktivieren Sie unter Optional 
software features die Kontrollkästchen 
Peptide Sequence Editor und 
BioConfirm Software.

g Deaktivieren Sie unter Non-MS 
detectors die Kontrollkästchen UV und 
ADC.

h Markieren Sie das Kontrollkästchen 
Show advanced parameters.

i Klicken Sie auf OK.

• Im Dialogfeld User Interface 
Configuration legen Sie fest, 
welche Befehle verfügbar sind. 

• Wenn eine Funktion nicht sichtbar 
ist, wurde sie vielleicht 
ausgeblendet, als ein 
Kontrollkästchen im Dialogfeld User 
Interface Configuration deaktiviert 
wurde.

Abb. 4 Konfigurieren der Benutzeroberfläche für ein GC/Q-TOF

Aufgabe 2. Benutzeroberfläche für GC konfigurieren

Schritte Ausführliche Anweisungen Anmerkungen
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1 Lerngrundlagen der qualitativen Analyse
Aufgabe 3. In das Chromatogramm hinein- und daraus herauszoomen
Aufgabe 3. In das Chromatogramm hinein- und daraus herauszoomen

In dieser Aufgabe werden Sie mit den Funktionen zum Hinein- und 
Herauszoomen des Programms zur qualitativen Analyse vertraut.
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Lerngrundlagen der qualitativen Analyse 1
Aufgabe 4. Ein Chromatogramm verankern
Aufgabe 4. Ein Chromatogramm verankern

In dieser Aufgabe verankern Sie ein Chromatogramm. Wenn Sie ein 
Chromatogramm verankern, bleibt das verankerte Chromatogramm 
permanent in der Anzeige, wenn Sie durch die anderen Chromatogramme 
scrollen, um sie anzuzeigen.

Aufgabe 4. Ein Chromatogramm verankern

Schritte Ausführliche Anweisungen Anmerkungen

• Verankern Sie ein Chromatogramm.
• Zeigen Sie alle 

Chromatogramme an.
• Achten Sie darauf, dass die 

Chromatogrammanzeigeliste 
auf 1 gesetzt ist.

• Wählen Sie im Fenster 
Chromatogram Results das 
zweite TIC.

• Verankern Sie dieses TIC.
• Scrollen Sie durch die 

Chromatogramme.
• Löschen Sie den Anker.

a Markieren Sie im Data Navigator die 
Kontrollkästchen für die 
Chromatogramme, die Sie in der 
vorherigen Aufgabe ausgeblendet 
haben.

b Achten Sie darauf, dass die maximale 
Anzahl von Fensterausschnitten im 
Fenster Chromatogram Results auf 1 
gesetzt ist.

c Wählen Sie im Fenster Chromatogram 
Results das zweite TIC.

d Klicken Sie mit der rechten Maustaste 
in das Chromatogramm und klicken Sie 
auf Set Anchor.

e Scrollen Sie mit der Scrollleiste im 
Fenster Chromatogram Results durch 
die Liste der Chromatogramme. Das 
zweite TIC bleibt stets als erstes 
Chromatogramm sichtbar. 

f Klicken Sie auf Chromatograms > 
Clear Anchor.

• Wenn Sie einen Anker für ein 
Chromatogramm festlegen, wird im 
Fenster Data Navigator ein 
Ankersymbol neben dem Namen 
des verankerten Chromatogramms 
angezeigt.

• Zwei Chromatogramme werden im 
Fenster Chromatogram Results 
angezeigt, nachdem Sie eines 
verankert haben, obwohl die 
Anzeigeliste 1 angibt. Dies bedeutet 
nun, dass Sie ein Chromatogramm 
zusätzlich zum verankerten 
Chromatogramm anzeigen.

• Sie können auch mit der rechten 
Maustaste auf das Chromatogramm 
klicken und im Kontextmenü auf 
Clear Anchor klicken.
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Aufgabe 4. Ein Chromatogramm verankern
Abb. 5 Verankertes TIC im Fenster Chromatogram Results

Aufgabe 4. Ein Chromatogramm verankern (Fortsetzung)

Schritte Ausführliche Anweisungen Anmerkungen
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Aufgabe 5. Fensterlayouts ändern
Aufgabe 5. Fensterlayouts ändern

In dieser Aufgabe verschieben Sie Fenster innerhalb der Hauptansicht und 
erstellen verschiedene Fensterlayouts.

Aufgabe 5. Fensterlayouts ändern

Schritte Ausführliche Anweisungen Anmerkungen

1 Ändern Sie das Fensterlayout:
• Ändern Sie die Fenstergröße.
• Speichern Sie ein Fensterlayout.
• Geben Sie das Layout frei.
• Legen Sie fest, dass das Fenster 

Chromatogram Results frei 
beweglich ist.

• Verschieben Sie das Fenster 
Chromatogram Results.

• Zeigen Sie die Tools zum 
Neupositionieren der Fenster an.

• Um die Größe eines Fensters zu 
ändern, ziehen Sie die Begrenzung 
zwischen den Fenstern.

• Um ein Fensterlayout zu speichern, 
klicken Sie auf Configuration > 
Window Layouts > Save Layout.

• Um ein Layout freizugeben, klicken Sie 
auf Configuration > Window 
Layouts > Lock Layout. 

• Um ein Fenster frei beweglich zu 
machen, klicken Sie mit der rechten 
Maustaste auf die Titelleiste des 
Fensters und klicken dann im 
Kontextmenü auf Floating.

• Um ein Fenster zu verschieben, klicken 
Sie auf die Titelleiste des Fensters und 
ziehen es an die gewünschte Position. 

• Um die Tools zum Neupositionieren 
anzuzeigen, ziehen Sie das Fenster 
über eines der anderen Fenster. Wenn 
ein Fenster das andere überlappt, zeigt 
das Programm mehrere Layouttools an, 
wie in Abb. 6 gezeigt.

• Wenn das Layout freigegeben ist, 
zeigt das System kein Häkchen 
neben dem Menü Lock Layout an.

• Sie können die Tools zum 
Neupositionieren nur verwenden, 
wenn das Layout freigegeben ist.

• Sie können ein Fenster auch frei 
beweglich machen, indem Sie auf 
die Titelleiste des Fensters 
doppelklicken.

• In der Software stehen viele 
verschiedene Layouts zur 
Verfügung. Sie können auch 
versuchen, andere Layouts zu 
laden.

• Die Software bietet mehrere 
verschiedene Arbeitsabläufe. Jeder 
Arbeitsablauf lädt ein anderes 
Layout. Beim Wechsel zu einem 
anderen Arbeitsablauf ändert sich 
auch das Layout.
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Aufgabe 5. Fensterlayouts ändern
Abb. 6 Tools zum Neupositionieren von Fenstern

2 Positionieren Sie das Fenster 
Chromatogram Results neu.
• Verschieben Sie das Fenster, 

sodass es sich über, links von, 
rechts von und dann unter den 
anderen Fenstern befindet.

• Verschieben Sie zwei Fenster 
gemeinsam, sodass sie sich 
übereinander befinden und nur 
über die Tabs am unteren Rand 
verfügbar sind. 

• Stellen Sie das Standardlayout 
wieder her.

• Wenn Sie den Cursor über eines der 
kleineren Symbole ziehen, wird das von 
Ihnen gezogene Fenster über, rechts 
von, unter oder links von allen anderen 
Fenstern platziert. 

• Ziehen Sie den Cursor über das 
größere Symbol. Das Fenster kann 
durch Ziehen des Cursors über die 
Kanten des größeren Symbols auch 
über, rechts von, unter oder links von 
den anderen Fenstern platziert werden.

• Um zwei Fenster übereinander zu 
legen, ziehen Sie den Cursor über die 
Mitte des größeren Symbols. Sie sehen 
eine Schattenversion der beiden 
übereinander gelegten Fenster. 
Beenden Sie das Ziehen der Maus. Die 
beiden Fenster werden übereinander 
gelegt.

• Klicken Sie auf Configuration > 
Window Layouts > Restore Default 
Layout.

• Der Cursor muss sich über einem 
der Pfeile in einem Feld befinden, 
damit die Neupositionierung 
durchgeführt werden kann.

• Durch Klicken auf den Befehl 
Restore Default Layout wird das im 
allgemeinen Arbeitsablauf und 
GC/Q-TOF Compound 
Screening-Arbeitsablauf 
verwendete Layout 
wiederhergestellt. Wenn Sie einen 
anderen Arbeitsablauf verwenden, 
müssen Sie das mit diesem 
Arbeitsablauf verwendete Layout 
laden.

Aufgabe 5. Fensterlayouts ändern (Fortsetzung)

Schritte Ausführliche Anweisungen Anmerkungen
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Aufgabe 6. Chromatogramme extrahieren
Aufgabe 6. Chromatogramme extrahieren

In dieser Aufgabe extrahieren und verbinden Sie Chromatogramme aus dem 
originalen TIC. 

Aufgabe 6. Chromatogramme extrahieren

Schritte Ausführliche Anweisungen Anmerkungen

1 Extrahieren und verbinden Sie zwei 
extrahierte Ionenchromatogramme 
(EICs) aus zwei Massen in der 
Datendatei Pest - 200 Scan.d.
• Die m/z-Werte sind 129,0 und 

414,2.
• Verbinden Sie die Peaks der 

einzelnen Massen nicht in einem 
Chromatogramm.

a Deaktivieren Sie im Fenster Data 
Navigator die Kontrollkästchen für die 
Datendateien außer Pest - 200 Scan.d.

b Öffnen Sie mithilfe der Option unten 
oder einer der Optionen rechts das 
Dialogfeld Extract Chromatograms: 
• Klicken Sie auf Chromatograms > 

Extract Chromatograms
c Klicken Sie in der List of opened data 

files auf Pest - 200 - Scan.d.
d Wählen Sie im Listenfeld Type den 

Eintrag EIC.
e Geben Sie im Feld m/z value(s) den 

Wert 129.0, 414.2 ein.
f Deaktivieren Sie ggf. das 

Kontrollkästchen Merge multiple 
masses into one chromatogram, um 
die EICs zu verbinden.

g Klicken Sie auf OK.
h Setzen Sie in der Symbolleiste 

Chromatogram Results die Option 
Maximum number of list panes auf 3.

• Sie können Chromatogramme auch 
mit einer der folgenden Methoden 
extrahieren:
• Klicken Sie mit der rechten 

Maustaste in das 
Chromatogramm und klicken Sie 
auf Extract Chromatograms.

• Markieren Sie im Data Navigator 
die Option TIC Scan für 
sulfas_PosMS.d, klicken Sie 
dann mit der rechten Maustaste 
auf TIC Scan und klicken Sie auf 
Extract Chromatograms.

• Sie können die MS-Stufe All oder 
MS verwenden.

• Beachten Sie, dass Sie das 
extrahierte Chromatogramm 
wahlweise auch nach der 
Extrahierung automatisch 
integrieren lassen können.

• Sie können auch ein 
Chromatogramm aus einem 
Massenspektrum extrahieren.
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Aufgabe 6. Chromatogramme extrahieren
Abb. 7 Das Dialogfeld Extract Chromatograms

Abb. 8 Verbundene extrahierte Ionenchromatogramme (EICs) 
verglichen mit dem originalen TIC

Aufgabe 6. Chromatogramme extrahieren (Fortsetzung)

Schritte Ausführliche Anweisungen Anmerkungen
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Aufgabe 7. Ein GC/MS-Chromatogramm interaktiv integrieren
Aufgabe 7. Ein GC/MS-Chromatogramm interaktiv integrieren

In dieser Aufgabe lernen Sie verschiedene Möglichkeiten kennen, ein 
Chromatogramm zu integrieren, Integrationsparameter zu ändern, um die 
Ergebnisse zu modifizieren, und das Signal-Rausch-Verhältnis für die 
integrierten Peaks für MS/MS-Daten zu berechnen.

Aufgabe 7. Ein Chromatogramm interaktiv integrieren (GC/MS)

Schritte Ausführliche Anweisungen Anmerkungen

1 Integrieren Sie das 
TIC-Scan-Chromatogramm für die 
Datendatei Pest - 200 - Scan.d mit 
einer beliebigen der rechts 
aufgelisteten Optionen.

a Markieren Sie die Datendatei Pest - 
200 - Scan.D im Fenster Data 
Navigator.

b Markieren Sie das 
TIC-Scan-Chromatogramm und 
verwenden Sie einen der folgenden 
Befehle:
• Klicken Sie in der Menüleiste auf 

Chromatograms > Integrate 
Chromatogram.

• Klicken Sie mit der rechten 
Maustaste an beliebiger Stelle in 
das Chromatogramm und klicken Sie 
auf Integrate Chromatograms.

• Wählen Sie im Fenster Data 
Navigator die Option Pest - 200 - 
Scan.D > User Chromatograms > 
TIC Scan, klicken Sie dann mit der 
rechten Maustaste auf den 
TIC-Scan, und klicken Sie auf 
Integrate Chromatogram.

• Beachten Sie, dass das Programm 
praktisch alle Peaks im 
Chromatogramm integriert hat.

• Sie wählen den für MS-, MS/MS- 
und GC-Daten zu verwendenden 
Integrator im Fenster Method 
Editor.

• Dieses Chromatogramm ist ein 
MS-Chromatogramm, sodass die im 
Abschnitt Integrate (MS) des 
Method Editor eingestellten Werte 
beim Integrieren dieses 
Chromatogramms verwendet 
werden.

2 Zeigen Sie nur zwei 
Chromatogramme gleichzeitig an.

• Wählen Sie in der Symbolleiste 
Chromatogram Results im Feld 
Maximum number of list panes den 
Wert 2.
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Aufgabe 7. Ein GC/MS-Chromatogramm interaktiv integrieren
Abb. 9 Integriertes TIC-Scan-Chromatogramm mit vielen kleinen Peaks 

3 Ändern Sie den Schwellenwert, um 
weniger Peaks zu integrieren.
• Ändern Sie den Schwellenwert, 

um nur die drei größten Peaks 
beizubehalten.

a Klicken Sie im Fenster Method 
Explorer auf Chromatogram > 
Integrate (MS), um das Fenster 
Integrate (MS) anzuzeigen.

b Wählen Sie den Integrator Agile.
c Klicken Sie auf die Registerkarte Peak 

Filters.
d Markieren Sie unter Maximum number 

of peaks die Option Limit (by height) 
to the largest und geben Sie 3 ein.

• Beachten Sie das blaue Dreieck, 
das angezeigt wird, wenn Sie eine 
Einstellung vom in der aktuellen 
Methode gespeicherten Wert 
abweichend ändern. Wenn Sie die 
Methode speichern, wird das 
Dreieck nicht mehr angezeigt.

Abb. 10 Registerkarte Peak Filters mit markiertem Limit (by height) to 
the largest

Aufgabe 7. Ein Chromatogramm interaktiv integrieren (GC/MS) (Fortsetzung)

Schritte Ausführliche Anweisungen Anmerkungen

Viele kleine Peaks werden integriert.
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Aufgabe 7. Ein GC/MS-Chromatogramm interaktiv integrieren
4 Integrieren Sie das 
Chromatogramm neu.

e Klicken Sie in der Symbolleiste Method 
Editor auf die Schaltfläche , um 
unter Verwendung der neuen 
Einstellung zu integrieren.

• Beachten Sie, dass jetzt nur die drei 
größten Peaks integriert werden.

• Der Peak bei 2,491 ist höher als der 
Peak bei 16,858 Minuten, also wird 
er als dritter Peak gewählt.

Abb. 11 Integriertes TIC-Scan-Chromatogramm bei Begrenzung der Anzahl von Peaks

5 Integrieren Sie das 
TIC-MRM-Chromatogramm für die 
Datendatei Pest - STD 200 
MRM.D.

a Wählen Sie im Fenster Data Navigator 
die Option TIC MRM für die Datendatei 
Pest - STD 200 MRM.d. 

b Integrieren Sie die Chromatogramme 
mit einem der folgenden Befehle.
• Klicken Sie in der Menüleiste auf 

Chromatograms > Integrate 
Chromatogram.

• Klicken Sie mit der rechten 
Maustaste an beliebiger Stelle in 
das Chromatogramm und klicken Sie 
auf Integrate Chromatograms.

• Klicken Sie im Fenster Data 
Navigator mit der rechten 
Maustaste auf das markierte 
Chromatogramm und klicken Sie auf 
Integrate Chromatogram.

c Zoomen Sie von 5,8 auf 8,5 Minuten.
d Setzen Sie Maximum number of list 

panes auf 2.

• Drücken Sie die Taste Strg, um 
mehrere Chromatogramme im 
Fenster Data Navigator zu 
markieren.

• Beachten Sie, dass das Programm 
praktisch alle Peaks im 
Chromatogramm integriert hat.

• Diese Chromatogramme sind 
MS/MS-Chromatogramme, sodass 
die im Abschnitt Integrate (MS/MS) 
des Method Editor eingestellten 
Werte beim Integrieren dieses 
Chromatogramms verwendet 
werden. Sie können einen zum 
Integrieren von 
MS-Chromatogrammen zu 
verwendenden Integrator und einen 
anderen, zum Integrieren von 
MS/MS-Chromatogrammen zu 
verwendenden Integrator 
auswählen.

Aufgabe 7. Ein Chromatogramm interaktiv integrieren (GC/MS) (Fortsetzung)

Schritte Ausführliche Anweisungen Anmerkungen
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Aufgabe 7. Ein GC/MS-Chromatogramm interaktiv integrieren
Abb. 12 Integrierte MRM-Chromatogramme 

6 Wählen Sie den Integrator 
MS/MS (GC). Ändern Sie den 
Filter, sodass nur Peaks mit einer 
absoluten Höhe von mindestens 
20.000 akzeptiert werden.

a Wählen Sie im Fenster Method 
Explorer die Option Chromatogram > 
Integrate (MS/MS).

b Wählen Sie MS/MS (GC) als 
Integrator.

c Klicken Sie auf die Registerkarte Peak 
Filters.

d Klicken Sie unter Filter on auf Peak 
height.

e Markieren Sie unter Height filters das 
Kontrollkästchen Absolute height.

f Geben Sie 60000 als Absolute height 
ein.

• Beachten Sie das blaue Dreieck, 
das angezeigt wird, wenn Sie eine 
Einstellung vom in der aktuellen 
Methode gespeicherten Wert 
abweichend ändern. Wenn Sie die 
Methode speichern, wird das 
Dreieck nicht mehr angezeigt.

Abb. 13 Registerkarte Peak Filters mit aktiviertem Absolute height

Aufgabe 7. Ein Chromatogramm interaktiv integrieren (GC/MS) (Fortsetzung)

Schritte Ausführliche Anweisungen Anmerkungen
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Aufgabe 7. Ein GC/MS-Chromatogramm interaktiv integrieren
7 Integrieren Sie das 
Chromatogramm neu.

g Klicken Sie in der Symbolleiste Method 
Editor auf die Schaltfläche .

• Beachten Sie, dass jetzt nur die 
größten Peaks integriert werden.

Abb. 14 Integrierte TIC- und EIC-MS/MS-Chromatogramme mit höherer Schwellenwerteinstellung

8 Stellen Sie die Einstellungen 
wieder her, die für die aktuelle 
Methode gespeichert werden, und 
schließen Sie den Method Editor.

a Wählen Sie im Method Explorer den 
Abschnitt Chromatogram > Integrate 
(MS/MS).

b Klicken Sie im Method Editor auf das 
Symbol .

c Wählen Sie im Method Explorer den 
Abschnitt Chromatogram > Integrate 
(MS).

d Klicken Sie im Method Editor auf das 
Symbol .

e Schließen Sie das Fenster Method 
Editor.

• Um Ihre Änderungen zu widerrufen 
und die Werte der geladenen 
Methode wiederherzustellen, 
klicken Sie in der Symbolleiste 
Method Editor auf das Symbol 
Restore to last saved values from 
file . 

9 Löschen Sie alle Chromatogramme 
mit Ausnahme des ursprünglichen. 
Löschen Sie die 
Integrationsergebnisse aus dem 
ursprünglichen Chromatogramm.

a Markieren Sie im Fenster Data 
Navigator unter Under User 
Chromatograms alle Chromatogramme 
mit Ausnahme des ursprünglichen.

b Klicken Sie mit der rechten Maustaste 
auf die markierten Chromatogramme 
und klicken Sie auf Delete.

c Wählen Sie alle TIC-Chromatogramme 
aus.

d Klicken Sie auf Chromatograms > 
Clear Results.

• Bei Verwendung des Befehls Clear 
Results werden die 
Chromatogramme nicht gelöscht; 
die mit den Chromatogrammen 
verbundenen Ergebnisse werden 
entfernt. In diesem Fall werden die 
Integrationswerte gelöscht.

Aufgabe 7. Ein Chromatogramm interaktiv integrieren (GC/MS) (Fortsetzung)

Schritte Ausführliche Anweisungen Anmerkungen

Der kleinere Peak bei 5,8 Minuten wird 
nicht mehr in die Integrationsergebnisse 
einbezogen, weil die absolute Höhe für 
diesen Peak unter 60.000 liegt.
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Aufgabe 8. Systemeignungswerte berechnen

In dieser Aufgabe lernen Sie verschiedene Möglichkeiten kennen, interaktiv ein 
Chromatogramm zu integrieren, Integrationsparameter zu ändern, um die 
Ergebnisse zu modifizieren, und das Signal-Rausch-Verhältnis für jeden Peak 
anzuzeigen. Außerdem lernen Sie, Systemeignungsberechnungen zu aktivieren.

Aufgabe 8. Ein Chromatogramm (MS) interaktiv integrieren

Schritte Ausführliche Anweisungen Anmerkungen

1 Integrieren Sie das 
MSD_mix_4stds_DB_spl200_03.d
- und Pest - 200 - 
Scan.d-Chromatogramm und 
verwenden Sie dazu beliebige der 
rechts aufgelisteten Optionen.

a Markieren Sie im Fenster Data 
Navigator das Kontrollkästchen neben 
der Datendatei 
MSD_mix_4stds_DB_spl200_03.d.

b Markieren Sie im Fenster Data 
Navigator das Kontrollkästchen neben 
der Datendatei Pest - 200 - Scan.d.

c Markieren Sie beide TICs.
d Integrieren Sie den TIC Scan für diese 

beiden Dateien unter Verwendung 
beliebiger der folgenden Optionen.
• Klicken Sie im Hauptmenü auf 

Chromatograms > Integrate 
Chromatogram.

• Markieren Sie das Chromatogramm. 
Klicken Sie dann mit der rechten 
Maustaste in das Chromatogramm 
und klicken Sie auf Integrate 
Chromatogram.

• Markieren Sie im Data Navigator die 
Option TIC Scan für beide 
Datendateien. Klicken Sie dann mit 
der rechten Maustaste auf eines der 
Chromatogramme und klicken Sie 
auf Integrate Chromatogram.

• Im allgemeinen Arbeitsablauf wird 
der Integrator General zur 
Integration verwendet, weil dieser 
Integrator in der Methode default.m 
ausgewählt ist. Für den GC/Q-TOF 
Compound Screening-Arbeitsablauf 
verwendet die Integration den 
Integrator Agile. 

• Sie können diesen Wert auf der 
Registerkarte Chromatogram > 
Integrate (MS) > Integrator ändern.

• Beachten Sie, dass die Integration 
mit Standardparametern sehr kleine 
Peaks erkennt.
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Aufgabe 8. Systemeignungswerte berechnen
Abb. 15 Eines der Kontextmenüs im Data Navigator und die integrierten Chromatogramme

2 Aktivieren Sie 
Systemeignungsberechnungen für 
die MS-Chromatogramme.

a Wählen Sie im Method Explorer 
Chromatogram > Integrate (MS), 
um die Registerkarte Integrator 
anzuzeigen.

b Klicken Sie auf die Registerkarte 
Suitability.

c Markieren Sie Enable system 
suitability calculations.

d Wählen Sie United States 
Pharmacopoeia (USP).

e Geben Sie im Feld Column void time 
den Wert 1 ein.

f Geben Sie im Feld Column length den 
Wert 3000 ein.

• Beachten Sie das blaue Dreieck, 
das angezeigt wird, wenn Sie eine 
Einstellung vom in der aktuellen 
Methode gespeicherten Wert 
abweichend ändern. Wenn Sie die 
Methode speichern, wird das 
Dreieck nicht mehr angezeigt.

• Die zum Einstellen mehrerer 
Spalten in der Integration Peak List 
verwendeten Algorithmen sind je 
nach ausgewähltem Arzneibuch 
unterschiedlich. Weitere 
Informationen finden Sie in der 
Online-Hilfe.

Aufgabe 8. Ein Chromatogramm (MS) interaktiv integrieren (Fortsetzung)

Schritte Ausführliche Anweisungen Anmerkungen
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Abb. 16 Registerkarte Chromatogram > Integrate (MS) Suitability

3 Integrieren Sie das 
Chromatogramm neu.

• Klicken Sie in der Symbolleiste Method 
Editor auf das Symbol Integrate 
Chromatogram , um unter 
Verwendung der neuen Einstellung zu 
integrieren.

4 Zeigen Sie die 
Systemeignungsberechnungen an.
• Öffnen Sie das Fenster 

Integration Peak List.
• Prüfen Sie die Werte für den 

Rauschbereich und berechnen 
Sie das Signal-Rausch-Verhältnis 
für die integrierten Peaks.

a Klicken Sie auf View > Integration 
Peak List.

b Klicken Sie mit der rechten Maustaste 
auf die Kopfzeile des Fensters Peaks 
und klicken Sie auf Floating.

c Klicken Sie mit der rechten Maustaste 
auf den Kopf einer beliebigen Spalte, 
die Sie nicht sehen möchten, und 
klicken Sie auf Remove Column. 

d Klicken Sie mit der rechten Maustaste 
auf einen beliebigen Spaltenkopf und 
klicken Sie auf Add/Remove Columns, 
um die sichtbaren Spalten zu ändern.

• Die Systemeignungsberechnungen 
werden in die Tabelle Integration 
Peak List einbezogen.

• Diese Werte umfassen k’, Tailing 
factor, Plates, Plates/M und 
Symmetry.

• Sie können 
Systemeignungsberechnungen 
auch für MS-, MS/MS- und 
GC-Chromatogramme aktivieren.

Abb. 17 Tabelle Integrated Peaks mit Systemeignungswerten

Aufgabe 8. Ein Chromatogramm (MS) interaktiv integrieren (Fortsetzung)

Schritte Ausführliche Anweisungen Anmerkungen

Tatsächliche 
Säulenunwirksamkeitszeit und 
Säulenlänge für diese 
Datendateien unterscheiden 
sich von diesen Werten. Diese 
werden nur für dieses Beispiel 
verwendet.
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5 Stellen Sie die Einstellungen für die 
Standardmethode wieder her und 
schließen Sie die Fenster Method 
Editor und Integration Peak List.

a Um Ihre Änderungen zu widerrufen 
und die Werte der Standardmethode 
wiederherzustellen, klicken Sie in der 
Symbolleiste Method Editor auf das 
Symbol Restore to last saved values 
from file . 

b Schließen Sie das Fenster Method 
Editor.

c Klicken Sie mit der rechten Maustaste 
auf den Titel des Fensters Integration 
Peak List und klicken Sie auf Floating.

d Klicken Sie auf View > Integration 
Peak List.

• Wenn Sie im Kontextmenü zum 
zweiten Mal auf den Befehl Floating 
klicken, wird das Fenster 
Integration Peak List dort 
angedockt, wo es sich ursprünglich 
befand.

Aufgabe 8. Ein Chromatogramm (MS) interaktiv integrieren (Fortsetzung)

Schritte Ausführliche Anweisungen Anmerkungen
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Aufgabe 9. Spektren aus einem Chromatogramm extrahieren

In dieser Aufgabe extrahieren Sie ein Spektrum exakt aus dem Bereich eines 
Chromatogramms, den Sie angeben. Das Programm zur qualitativen Analyse 
extrahiert ein Spektrum aus einem spezifischen Datenpunkt oder ein 
Durchschnittsspektrum aus einem Durchschnitt mehrerer Datenpunkte 
oder -bereiche. 

Aufgabe 9. Spektren aus einem Chromatogramm extrahieren

Schritte Ausführliche Anweisungen Anmerkungen

1 Untersuchen Sie ein 
Chromatogramm, um das 
Präkursor-Ion und Produkt-Ion für 
die letzten paar Peaks von Pest - 
STD 200 MRM.d anzuzeigen.
• Zoomen Sie auf den Bereich 

zwischen 13 und 16 Minuten.
• Verwenden Sie das Symbol Walk 

Chromatogram.
• Untersuchen Sie die etwa bei 

13 Minuten beginnenden 
Spektren und bewegen Sie den 
Pfeil nach rechts. 

a Markieren Sie die Zeile Pest - 200 - 
MRM.D im Fenster Data Navigator.

b Schließen Sie das Fenster Method 
Editor.

c Schließen Sie das Fenster MS 
Spectrum Results.

d Klicken Sie im Fenster Data Navigator 
auf das TIC MRM-Chromatogramm.

e Klicken Sie in der Symbolleiste 
Chromatogram Results auf das Symbol 
Autoscale Y-axis during Zoom .

f Wählen Sie 1 für Maximum number of 
list panes.

g Um auf ein paar Peaks zu zoomen, 
klicken Sie mit der rechten Maustaste 
über den Peak bei 13 Minuten, ziehen 
ihn zu 16 Minuten und geben ihn frei. 

h Klicken Sie in der Symbolleiste 
Chromatogram Results auf das Symbol 
Walk Chromatogram .

i Bewegen Sie den Walk 
Chromatogram-Cursor bei etwa 
13 Minuten über die X-Achse und 
klicken Sie. 

j Um von Spektrum zu Spektrum zu 
navigieren, verwenden Sie die Rechts- 
und Links-Pfeiltaste der Tastatur.

• Das Walk Chromatogram-Tool ist 
besonders bei MS/MS-Daten zur 
Identifikation von Präkursor- und 
Produkt-Ionen von Nutzen.

• Das Spektrum wird für jeden Punkt, 
auf den Sie im Fenster 
Chromatogram Results klicken, 
automatisch im Fenster Spectrum 
Preview angezeigt, das automatisch 
geöffnet wird.

• Manchmal werden zwei Spektren 
im Fenster Spectrum Preview 
angezeigt. Beispielsweise werden 
im Fenster Spectrum Preview zwei 
Spektren für jeden Punkt angezeigt, 
auf den Sie in der Nähe des bei 
13,431 Minuten liegenden Peaks 
klicken.
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Aufgabe 9. Spektren aus einem Chromatogramm extrahieren
Abb. 18 Untersuchen Sie das Chromatogramm, um die beiden MRM-Spektren für den Peak bei 
13,43 Minuten anzuzeigen

Aufgabe 9. Spektren aus einem Chromatogramm extrahieren

Schritte Ausführliche Anweisungen Anmerkungen
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2 Extrahieren Sie Spektren bei 
spezifischen Datenpunkten für den 
Peak bei 5,2 Minuten und den Peak 
bei 14,3 Minuten der Datendatei 
Pest - STD 200 MRM.d.
• Extrahieren Sie ein Spektrum 

aus dem Peak bei oder in der 
Nähe von 5,2 Minuten und dann 
bei einem der Täler unter 
Verwendung einer beliebigen der 
unter „Anmerkungen“ 
beschriebenen Optionen.

• Extrahieren Sie ein Spektrum 
aus dem Peak bei oder in der 
Nähe von 14,3 Minuten (noch 
nicht das Tal).

• Ändern Sie die Anzeige, sodass 
mindestens drei Spektren 
angezeigt werden.

a Klicken Sie in der Symbolleiste 
Chromatogram Results auf das Symbol 
Range Select .

b Schließen Sie das Fenster Spectrum 
Preview.

c Klicken Sie in der Symbolleiste 
Chromatogram Results auf das Symbol 
Zoom Out .

d Um auf den Peak bei 5,2 Minuten zu 
zoomen, klicken Sie mit der rechten 
Maustaste über den Peak bei 4,0 Min., 
ziehen ihn auf 6,0 Min. und geben ihn 
frei. 

e Extrahieren Sie mit einer der in der 
Spalte „Anmerkungen“ aufgelisteten 
Methoden ein Spektrum aus einem 
Peak in der Nähe von 5,2 Min.

f Extrahieren Sie das Spektrum aus 
einem Tal in der Nähe von 5,1 Min.

g Klicken Sie in der Symbolleiste 
Chromatogram Results auf das Symbol 
Zoom Out .

h Zoomen Sie auf den Bereich zwischen 
14 und 15 Min. 

i Extrahieren Sie mit einer der in der 
Spalte „Anmerkungen“ aufgelisteten 
Methoden ein Spektrum aus einem 
Peak in der Nähe von 14,3 Min. 
(Extrahieren Sie noch nicht das 
Talspektrum.)

j Wählen Sie ggf. in der Symbolleiste 
MS Spectrum Results im Symbol 
Maximum number of list panes den 
Wert 4.

• Achten Sie beim Zoomen darauf, 
dass das Symbol AutoScale Y-axis 
during Zoom  aktiviert ist. Der 
Hintergrund des Symbols ist 
orange, wenn es aktiviert ist.

• Sie können ein Spektrum auch mit 
einer der folgenden Methoden 
extrahieren:
• Doppelklicken Sie im 

Chromatogramm auf den 
Datenpunkt. 

• Klicken Sie im Chromatogramm 
auf den Datenpunkt und dann mit 
der rechten Maustaste an 
beliebiger Stelle in das 
Chromatogramm. Klicken Sie auf 
Extract MS Spectrum. Das 
Dialogfeld Extract Spectrum wird 
geöffnet. Achten Sie darauf, dass 
die Datei Pest - STD 200 MRM.d 
ausgewählt ist, und klicken Sie 
im Dialogfeld Extract Spectrum 
auf Extract.

• Beachten Sie, dass beim ersten 
Extrahieren eines Spektrums das 
Fenster MS Spectrum Results mit 
dem Spektrum angezeigt wird und 
Typ und Retentionszeit des 
Spektrums unter User Spectra 
angezeigt werden. Alle in der Folge 
extrahierten Spektren werden 
ebenfalls an beiden Positionen 
angezeigt.

• Wenn Sie ein MS-Spektrum aus 
dem Peak in der Nähe von 
14,3 Minuten extrahieren, werden 
zwei Spektren extrahiert, weil bei 
diesem Peak zwei Übergänge 
stattfinden.

Aufgabe 9. Spektren aus einem Chromatogramm extrahieren

Schritte Ausführliche Anweisungen Anmerkungen
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Abb. 19 Hauptfenster mit zwei MRM-Spektren aus dem Peak in der Nähe von 5,2 Minuten und zwei 
MRM-Spektren aus dem Peak bei 14,3 Minuten

Aufgabe 9. Spektren aus einem Chromatogramm extrahieren

Schritte Ausführliche Anweisungen Anmerkungen
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3 Extrahieren Sie ein MS-Spektrum 
für das Tal bei 14,35 Minuten der 
Datendatei Pest - STD 200 MRM.d. 
• Rufen Sie Spectrum Preview auf.
• Extrahieren Sie ein Spektrum 

aus dem Tal bei RT 14,3 Minuten.
• Kopieren Sie dieses Spektrum in 

den Ordner User Spectra.
• Ändern Sie die Anzeige, sodass 

6 Spektren angezeigt werden.
• Schließen Sie Spectrum Preview.

a Klicken Sie auf das Symbol Spectrum 
Preview .

b Extrahieren Sie ein Spektrum aus 
einem Tal bei 14,3 Minuten.

c Klicken Sie mit der rechten Maustaste 
im Fenster Spectrum Preview auf das 
Spektrum und klicken Sie auf Copy to 
User Spectra. Die Spektren werden im 
Data Navigator in den Abschnitt User 
Spectra kopiert und im Fenster MS 
Spectrum Results angezeigt.

d Klicken Sie auf den Abwärtspfeil 
neben der 
Spektrumfensterausschnitt-Liste und 
wählen Sie 6.

e Schließen Sie das Fenster Spectrum 
Preview.

• Wenn Spectrum Preview aktiviert 
ist, zeigt das System jedes manuell 
ausgewählte Spektrum im Fenster 
Spectrum Preview an, aber nicht im 
Abschnitt User Spectra des Data 
Navigator.

• Wenn Spectrum Preview aktiviert 
ist, überschreibt die qualitative 
Analyse das vorherige Spektrum, 
wenn Sie ein neues Spektrum 
extrahieren.

• Der Modus Spectrum Preview ist 
von Nutzen, wenn Sie schnell die 
Spektren in Ihrem Chromatogramm 
überprüfen und nur einen Teil der 
Spektren speichern möchten.

Aufgabe 9. Spektren aus einem Chromatogramm extrahieren

Schritte Ausführliche Anweisungen Anmerkungen
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Aufgabe 9. Spektren aus einem Chromatogramm extrahieren
Abb. 20 Fenster Chromatogram Results und MS Spectrum Results

4 Extrahieren Sie ein Spektrum, das 
den Durchschnitt aller Punkte 
innerhalb eines angegebenen 
Bereichs für den Peak bei 
14,3 Minuten für die Datendatei 
Pest - STD 200 MRM.d bildet:
• Zoomen Sie heraus.
• Verwenden Sie in der 

Symbolleiste Chromatogram das 
Symbol Range Select.

• Legen Sie den Bereich über den 
gesamten Peak hinweg fest. 

• Extrahieren Sie das Spektrum 
mit beliebigen der aufgelisteten 
Optionen.

a Klicken Sie in der Symbolleiste 
Chromatogram auf das Symbol Range 
Select .

b Klicken Sie links von der Basis des 
Peaks bei 14,3 Minuten und ziehen Sie 
nach rechts zur Basis des Peaks. 

c Extrahieren Sie das 
Durchschnittsspektrum mit einer der 
Optionen rechts.

d Wählen Sie im Fenster MS Spectrum 
Results im Feld Maximum number of 
list panes den Wert 2.

• Sie können durch Doppelklicken auf 
den gewählten Bereich im 
Chromatogramm ein 
Durchschnittsspektrum extrahieren. 

• Oder klicken Sie mit der rechten 
Maustaste an beliebiger Stelle in 
das Chromatogramm und klicken 
Sie im Kontextmenü auf Extract MS 
Spectrum.

• Beachten Sie, dass zwei 
Durchschnitts-MRM-Spektren 
angezeigt werden.

Aufgabe 9. Spektren aus einem Chromatogramm extrahieren

Schritte Ausführliche Anweisungen Anmerkungen
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Abb. 21 Chromatogram Results und MS Spectrum Results zeigen zwei Durchschnittsspektren an

5 Extrahieren Sie Spektren, die den 
Durchschnitt der Bereiche von 
Peaks bei 5,2 Minuten und 
14,3 Minuten für die Datendatei 
Pest - STD 200 MRM.d zusammen 
darstellen.
• Hinweis: Verwenden Sie das 

Symbol Range Select und die 
Taste Strg zur Auswahl des Peak 
1-Bereichs, der bei dem auf 
halbem Wege liegenden Punkt 
festgelegt wird.

• Extrahieren Sie die Spektren mit 
einer der Optionen rechts.

a Klicken Sie in der Symbolleiste 
Chromatogram Results auf das Symbol 
Zoom Out .

b Drücken Sie die Taste Strg.
c Klicken Sie an der linken Seite des 

Peaks bei 5,2 Minuten, ziehen Sie nach 
rechts von diesem Peak und geben Sie 
die Maus frei.

d Geben Sie die Taste Strg frei.
e Extrahieren Sie die 

Durchschnittsspektren mit dieser 
Option oder der Option rechts:
• Doppelklicken Sie in einem der 

Peaks in den ausgewählten Bereich.

• Denken Sie daran, dass für den 
zweiten Peak bereits in Schritt 4 ein 
Bereich ausgewählt wurde.

• Um Spektren zu extrahieren, 
können Sie auch mit der rechten 
Maustaste an beliebiger Stelle in 
das Chromatogramm klicken und 
auf Extract MS Spectrum klicken. 
Das Dialogfeld Extract Spectrum 
wird angezeigt. Klicken Sie auf 
Extract.

Aufgabe 9. Spektren aus einem Chromatogramm extrahieren

Schritte Ausführliche Anweisungen Anmerkungen
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Aufgabe 9. Spektren aus einem Chromatogramm extrahieren
Abb. 22 Zwei Durchschnittsspektren aus zwei verschiedenen Bereichen im Chromatogramm

Aufgabe 9. Spektren aus einem Chromatogramm extrahieren

Schritte Ausführliche Anweisungen Anmerkungen

Das erste Spektrum weist Übergänge 
von beiden Zeiträumen auf. Das 
zweite Spektrum hat nur einen 
Zeitraum, weil der 160,00 -> 
**-Übergang in dem Peak bei 
5,2 Minuten nicht vorhanden ist.
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6 Subtrahieren Sie stets ein 
Hintergrundspektrum, wenn Sie 
ein Peak-Spektrum aus Pest - STD 
200 MRM.d extrahieren.
• Löschen Sie im Data Navigator 

jegliche Scans unter User 
Spectra.

• Extrahieren Sie ein 
Hintergrundspektrum, das den 
Durchschnitt eines Spektrums 
am Beginn des Peaks und eines 
Spektrums am Ende des Peaks 
darstellt.

• Extrahieren Sie ein 
Peak-Spektrum aus den 
integrierten Peaks.

a Klicken Sie im Data Navigator auf die 
Zeile User Spectra. Klicken Sie mit der 
rechten Maustaste auf die Zeile User 
Spectra und klicken Sie auf Delete.

b Klicken Sie auf Yes.
c Wählen Sie im Method Explorer die 

Option Spectrum > Extract 
(MS/MS). 

d Klicken Sie auf die Registerkarte Peak 
Spectrum Extraction (MS/MS), falls 
nicht sichtbar.

e Wählen Sie im Feld Peak spectrum 
background MS/MS die Option 
Average of spectra at peak start and 
end.

f Klicken Sie in der Symbolleiste 
Chromatogram Results auf das Symbol 
Peak Select .

g Klicken Sie auf den Befehl 
Chromatograms > Integrate.

h Wählen Sie den Peak bei 
5,206 Minuten.

i Klicken Sie mit der rechten Maustaste 
und klicken Sie im Kontextmenü auf 
Extract Peak Spectrum.

• Beachten Sie, dass am Ende dieses 
Prozesses von allen extrahierten 
Peak-Spektren automatisch das 
zugewiesene Hintergrundspektrum 
subtrahiert wird.

Aufgabe 9. Spektren aus einem Chromatogramm extrahieren

Schritte Ausführliche Anweisungen Anmerkungen
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Abb. 23 Peak-Spektren, von denen ein Hintergrundspektrum subtrahiert ist

Aufgabe 9. Spektren aus einem Chromatogramm extrahieren

Schritte Ausführliche Anweisungen Anmerkungen
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7 Integrieren und extrahieren Sie 
Peak-Spektren von der Datendatei 
Pest - STD 200 MRM.d.

a Klicken Sie im Fenster Data Navigator 
auf das TIC MRM-Chromatogramm.

b Klicken Sie auf Chromatograms > 
Integrate and Extract Peak Spectra.

• Die Peak-Spektren, die Sie im 
vorherigen Schritt manuell 
extrahiert haben, werden 
automatisch gelöscht, weil 
standardmäßig das 
Kontrollkästchen Clear previous 
peak spectra auf der Registerkarte 
Chromatograms > Integrate 
(MS/MS) > Results markiert wird.

Abb. 24 Peak-Spektren integrieren und extrahieren

8 Entfernen Sie 
Integrationsergebnisse und 
Peak-Spektren.

a Wählen Sie die Datendatei Pest - Std 
200 MRM.d.

b Klicken Sie auf Chromatograms > 
Clear Results > Include Peak 
Spectra.

• Stattdessen können Sie auf 
Chromatograms > Clear Results > 
Only Chromatograms klicken, wenn 
Sie die Peak-Spektren nicht löschen 
möchten.

Aufgabe 9. Spektren aus einem Chromatogramm extrahieren

Schritte Ausführliche Anweisungen Anmerkungen
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Aufgabe 10. Anmerkungen hinzufügen
Aufgabe 10. Anmerkungen hinzufügen

Folgenden Grafikfenstern können Sie eine Bild- oder Textanmerkung 
hinzufügen:

• Fenster Chromatogram Results

• Fenster MS Spectrum Results

Wenn Sie die Ergebnisse für die Datendatei speichern, werden Anmerkungen 
auch gespeichert.

Aufgabe 10. Eine Anmerkung hinzufügen

Schritte Ausführliche Anweisungen Anmerkungen

1 Wählen Sie die Datendatei 
MSD_mix_4stds_DG_spl200_03.d 
aus. Blenden Sie die übrigen 
Chromatogramme aus.

a Markieren Sie im Fenster Data 
Navigator das Kontrollkästchen neben 
MSD_mix_4stds_DB_spl200_03.d.

b Klicken Sie auf Edit > Show > Only 
Highlighted.

• Die Chromatogramme für die 
anderen Datendateien werden 
automatisch ausgeblendet.

2 Wählen Sie die Stelle im 
Chromatogramm, an der Sie eine 
Textanmerkung hinzufügen 
möchten.

a Klicken Sie in der Symbolleiste des 
Fensters Chromatogram Results auf 
das Tool Annotation ( ).

b Bewegen Sie den Cursor an die Stelle 
im 
Chromatogramm-Fensterausschnitt, 
wo Sie die Anmerkung hinzufügen 
möchten.

c Klicken Sie mit der rechten Maustaste 
und dann auf Add Text Annotation.

• Der Cursor wird zu einem 
Fadenkreuz. Wählen Sie mit diesem 
Cursor die exakte Position aus, an 
der Sie die Anmerkung hinzufügen 
möchten.

• Die Symbolleiste Annotate ist im 
Fenster Chromatogram Results 
verfügbar.

• Sie können auch im Fenster MS 
Spectrum Results Anmerkungen 
hinzufügen.
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3 Fügen Sie die Informationen zur 
Textanmerkung im Dialogfeld 
Add/Edit Text Annotation hinzu.

a Geben Sie den Text für die 
Anmerkung ein.

b Wählen Sie die Text color.
c Wählen Sie die Orientation.
d Wählen Sie Font style und Font size 

aus.
e Klicken Sie entweder auf Anchored 

oder Floating. Wenn Sie auf Anchored 
klicken, wählen Sie die Optionen für 
den Zeiger auf die Textanmerkung. 
Wenn Sie auf Floating klicken, können 
Sie die relative Position ändern. Es ist 
einfacher, die Position interaktiv im 
Grafikfenster zu ändern.

f Klicken Sie auf OK.

• Sie können einem Chromatogramm 
oder Spektrum mehrere 
Anmerkungen hinzufügen.

• Mithilfe der Symbole in der 
Symbolleiste Annotate können Sie 
alle Anmerkungen auswählen, 
Anmerkungen löschen und 
bearbeiten.

Abb. 25 Dialogfeld Add/Edit Text Annotation und Fenster Chromatogram Results

Aufgabe 10. Eine Anmerkung hinzufügen (Fortsetzung)

Schritte Ausführliche Anweisungen Anmerkungen

Die Symbolleiste Annotate ist nur verfügbar, wenn das Tool 
Annotate ausgewählt ist.
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4 Wählen Sie die Stelle im 
Chromatogramm, an der Sie eine 
Bildanmerkung hinzufügen 
möchten.

a Bewegen Sie den Cursor an die Stelle 
im Chromatogramm-
Fensterausschnitt, wo Sie die 
Anmerkung hinzufügen möchten.

b Klicken Sie mit der rechten Maustaste 
und dann auf Add Image Annotation.

• Sie können eine JPG- oder 
MOL-Bilddatei hinzufügen.

5 Fügen Sie die Informationen zur 
Textanmerkung im Dialogfeld 
Add/Edit Text Annotation hinzu.

a Geben Sie den Text für die 
Anmerkung ein.

b Geben Sie 50 für die Scale width ein.
c Markieren Sie das Kontrollkästchen 

Lock aspect ratio.
d Klicken Sie auf Floating. Sie können 

die relative Position ändern. Es ist 
einfacher, die Position interaktiv im 
Grafikfenster zu ändern.

e Klicken Sie auf OK.
f Verschieben Sie das Bild zur oberen, 

rechten Ecke des Chromatogramms.

• Die Datei Agilent_Logo.tif ist im 
Ordner \\MassHunter\Report 
Templates\Qual\B.05.00\en-US\
Letter enthalten. Sie müssen Sie in 
eine JPG-Datei umwandeln.

• Sie können einem Chromatogramm 
oder Spektrum mehrere 
Anmerkungen hinzufügen.

Aufgabe 10. Eine Anmerkung hinzufügen (Fortsetzung)

Schritte Ausführliche Anweisungen Anmerkungen
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Abb. 26 Dialogfeld Add/Edit Image Annotation und Fenster Chromatogram Results

6 Zoomen Sie auf den ersten Peak. • Zoomen Sie auf einen Bereich um den 
ersten Peak bei 5,5 Minuten.

Abb. 27 Dialogfeld Add/Edit Image Annotation und Fenster Chromatogram Results

Aufgabe 10. Eine Anmerkung hinzufügen (Fortsetzung)

Schritte Ausführliche Anweisungen Anmerkungen

Wenn eine Anmerkung verankert ist, bleibt 
sie an der entsprechenden Position. Wenn 
Sie auf einen anderen Peak zoomen, ist eine 
verankerte Anmerkung möglicherweise nicht 
sichtbar. Wenn eine Anmerkung frei 
beweglich ist, wird die Anmerkung immer 
relativ zur oberen linken Ecke des Fensters 
an derselben Position angezeigt.
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7 Wechseln Sie wieder zum Tool 
Range Select im Fenster 
Chromatogram Results. Löschen 
Sie zuvor die Anmerkung.

a Klicken Sie auf das Symbol , um 
alle Anmerkungen zu entfernen.

b Klicken Sie in der Symbolleiste 
Chromatogram Results auf das Symbol 

 (Range Select).

• Wenn Sie die Anmerkungen mit den 
Datendateiergebnissen speichern 
möchten, siehe „Aufgabe 17. 
Ergebnisse speichern“ auf Seite 74.

• Sie können in der Symbolleiste 
Chromatogram Results zwischen 
fünf verschiedenen Tools wechseln. 
Weitere Informationen finden Sie in 
der Online-Hilfe. Die fünf Tools sind:
• Range Select
• Peak Select
• Manual Integration
• Walk Chromatogram
• Annotation Mouse

Aufgabe 10. Eine Anmerkung hinzufügen (Fortsetzung)

Schritte Ausführliche Anweisungen Anmerkungen
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Aufgabe 11. Massenmessschieber hinzufügen

Ein Messschieber zeigt den Unterschied zwischen zwei Punkten in einem 
Spektrum. Sie können im Fenster MS Spectrum Results einen Messschieber 
hinzufügen.

Wenn Sie die Ergebnisse für die Datendatei speichern, werden Messschieber 
auch gespeichert.

Aufgabe 11. Massenmessschieber hinzufügen

Schritte Ausführliche Anweisungen Anmerkungen

1 Integrieren und extrahieren Sie 
Peak-Spektren aus 
MSD_mix_4stds_DG_spl200_03.d.

a Markieren Sie im Fenster Data 
Navigator das Kontrollkästchen neben 
MSD_mix_4stds_DB_spl200_03.d.

b Klicken Sie auf Edit > Show > Only 
Highlighted.

c Klicken Sie auf Chromatograms > 
Integrate and Extract Peak Spectra.

d Schließen Sie das Fenster Method 
Editor.

2 Fügen Sie den Messschieber dem 
in der vorherigen Aufgabe 
erstellten Peak-Spektrum hinzu.

a Klicken Sie in der Symbolleiste des 
Fensters MS Spectrum Results auf das 
Tool Delta Mass Caliper ( ).

b (Optional) Wählen Sie in der 
Messschieber-Symbolleiste Profile 
Point to Point als Messschiebertyp 
aus.

c Zoomen Sie auf 66 bis 132 m/z.
d Bewegen Sie den Cursor an die Stelle 

im Spektrumfensterausschnitt, wo Sie 
den Messschieber hinzufügen 
möchten.

e Ziehen Sie den Cursor zum Endpunkt 
des Messschiebers im Spektrum. Beim 
Ziehen des Cursors ändert sich der 
Deltamassenwert. Wenn Sie die 
Maustaste freigeben, wird der 
Messschieber hinzugefügt. 

• Der Cursor nimmt Pfeilform an. Mit 
diesem Cursor wählen Sie Start- 
und Endpunkt des Messschiebers. 

• Sie können den Messschiebertyp 
nicht auswählen, wenn im 
Spektrum ein Schwerpunkt liegt, 
weil Profile Point to Point keine 
Wirkung auf Schwerpunktdaten hat.

• Der „Dreieck“-Cursor wird an die 
Spitze des ausgewählten Peaks 
gesetzt.
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Lerngrundlagen der qualitativen Analyse 1
Aufgabe 11. Massenmessschieber hinzufügen
3 Ändern Sie den Messschieber 
derart, dass eine andere Farbe 
verwendet wird.

a Klicken Sie auf den im vorherigen 
Schritt erstellten Messschieber.

b Klicken Sie in der Symbolleiste MS 
Spectrum Results Caliper auf die 
Schaltfläche Caliper Properties ( ).

c (Optional) Geben Sie die Werte Start X 
und Start Y ein.

d Wählen Sie die Text color.
e Wählen Sie Font style und Font size 

aus.
f Klicken Sie auf OK.

• Sie können einem Spektrum 
mehrere Messschieber hinzufügen.

• Mithilfe der Symbole in der 
Messschieber-Symbolleiste können 
Sie alle Messschieber auswählen, 
Messschieber löschen und 
bearbeiten.

Abb. 28 Dialogfeld Delta Mass Caliper Settings und Fenster MS Spectrum Results

4 Löschen Sie 
Integrationsergebnisse und 
Spektren.

a Klicken Sie auf Chromatograms > 
Clear Results > Include Peak 
Spectra.

b Klicken Sie auf das Tool Range Select.

• Wenn Sie die Messschieber mit den 
Datendateiergebnissen speichern 
möchten, siehe „Aufgabe 17. 
Ergebnisse speichern“ auf Seite 74.

Aufgabe 11. Massenmessschieber hinzufügen (Fortsetzung)

Schritte Ausführliche Anweisungen Anmerkungen
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Aufgabe 11. Massenmessschieber hinzufügen
50 Agilent MassHunter Workstation Software - Handbuch zur Einarbeitung in die qualitative Analyse für LC/MS



Agilent MassHunter Workstation Software Qualitative Analyse
Einarbeitungshandbuch
2
Finden und identifizieren

Aufgabe 12. Verbindungen durch Chromatogrammdekonvolution 
finden 52

Aufgabe 13. Verbindungen mit dem Search Library-Algorithmus 
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In diesen Aufgaben finden und identifizieren Sie Verbindungen in 
GC/MS-Datendateien.

Jede Übung wird in einer dreispaltigen Tabelle dargestellt:

• Schritte – lernen Sie das Programm mit diesen allgemeinen Anweisungen 
selbstständig kennen.

• Ausführliche Anweisungen – benutzen Sie sie, wenn Sie Hilfe benötigen 
oder einen schrittweisen Lernprozess bevorzugen.

• Anmerkungen – lesen Sie sie, um Tipps und weitere Informationen zu den 
einzelnen Schritten der Übung zu erfahren.
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2 Finden und identifizieren
Aufgabe 12. Verbindungen durch Chromatogrammdekonvolution finden
Aufgabe 12. Verbindungen durch Chromatogrammdekonvolution 
finden

Dieser Algorithmus zum Finden von Verbindungen identifiziert Verbindungen 
in GC/MS-Daten und erstellt für jede Verbindung ein bereinigtes 
MS-Spektrum. Mit dieser Funktionalität können Sie mühelos Informationen 
aus komplexen Daten gewinnen. Sie können den Algorithmus zum Finden von 
Verbindungen durch Chromatogrammdekonvolution nur auf 
GC/MS-Probendaten anwenden, die mittels Scan, Produkt-Ionen-Scan oder 
Neutralverlust-Scan erfasst wurden.

Diese Aufgabe zeigt, wie Verbindungen durch Chromatogrammdekonvolution 
mit präzisen Massendaten gefunden werden. Sie können Verbindungen auch 
durch Chromatogrammdekonvolution mit Masseneinheitendaten finden, 
nachdem Sie das Extrahierungsfenster gewechselt haben.

Aufgabe 12. Verbindungen durch Chromatogrammdekonvolution finden (GC/MS)

Schritt Ausführliche Anweisungen Anmerkungen

1 Öffnen Sie das TIC für die Datendatei 
MSD_mix_4stds_DG_spl200_03.d.

a Wenn das Programm nicht geöffnet 
ist, doppelklicken Sie auf das Symbol 
MassHunter Qualitative Analysis. 
Klicken Sie andernfalls auf File > Open 
Data File.

b Klicken Sie im 
GC-Beispieldatendatei-Ordner auf die 
Datendatei 
MSD_mix_4stds_DG_spl200_03.d.

c Deaktivieren Sie das Kontrollkästchen 
Load result data und klicken Sie auf 
Open.

• Der Algorithmus zum Finden von 
Verbindungen durch 
Chromatogrammdekonvolution ist 
mit beiden GC/QQQ- und 
GC/Q-TOF-Datendateien einsetzbar.

Abb. 29 TIC-Chromatogramm aus Pest - 200 - Scan.d
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Finden und identifizieren 2
Aufgabe 12. Verbindungen durch Chromatogrammdekonvolution finden
2 Konfigurieren Sie die 
Benutzeroberfläche zum Einsatz 
mit GC-Daten.

• Folgen Sie den Anweisungen in 
„Aufgabe 2. Benutzeroberfläche für 
GC/MS-Daten konfigurieren“ auf 
Seite 12.

• Laden Sie für diese Beispiele den 
GC/Q-TOF Compound 
Screening-Arbeitsablauf.

3 Finden Sie Verbindungen mit dem 
Algorithmus zur 
Chromatogrammdekonvolution.
• Wählen Sie den Integrator Agile.
• Geben Sie einen 

SNR-Schwellenwert von 20 ein.
• Geben Sie 100 ppm für Left m/z 

delta und Right m/z delta ein.

a Wählen Sie im Fenster Method 
Explorer die Option Find Compounds > 
Find by Chromatogram 
Deconvolution.

b Geben Sie auf der Registerkarte 
Settings unter Peak filter den Wert 20 
für SNR threshold ein.

c Wählen Sie PPM für m/z delta units.
d Geben Sie 100 für Left m/z delta und 

100 für Right m/z delta ein.

• Der Abschnitt Find by 
Chromatogram Deconvolution ist 
auch im Abschnitt GC/Q-TOF 
Compound Screening verfügbar.

• Wenn Sie Masseneinheitendaten 
haben, geben Sie 0.3 AMU für Left 
m/z delta und 0.7 AMU für Right 
m/z delta ein.

• Sie können den gesamten 
Ergebnissatz für eine gefundene 
Verbindung extrahieren, wenn Sie 
die Verbindung markieren und die 
Menüoption Compounds > Extract 
Complete Result Set wählen.

Abb. 30 Registerkarte Settings im Abschnitt Find Compounds by 
Chromatogram Deconvolution

Aufgabe 12. Verbindungen durch Chromatogrammdekonvolution finden (GC/MS)

Schritt Ausführliche Anweisungen Anmerkungen
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2 Finden und identifizieren
Aufgabe 12. Verbindungen durch Chromatogrammdekonvolution finden
• Wählen Sie das Extrahieren von 
EIC-, MS- und MS/MS-Spektren.

e Klicken Sie auf die Registerkarte 
Results.

f Markieren Sie die Kontrollkästchen 
Extract EIC, Extract ECC, Extract 
cleaned spectrum und Extract raw 
spectrum.

g Klicken Sie auf , um den Find 
Compounds by Chromatogram 
Deconvolution-Algorithmus auf die 
Datendatei anzuwenden. 

h Klicken Sie ggf. auf den Befehl View > 
Compound List.

• Das Programm zur qualitativen 
Analyse findet unter diesen 
Bedingungen 4 Verbindungen.

• Wenn die Datendatei nicht indiziert 
ist, kann die Ausführung dieses 
Algorithmus viel Zeit kosten.

4 Untersuchen Sie die Verbindungen. 
Siehe Abbildung 31 auf Seite 55.

a Wählen Sie in der Symbolleiste MS 
Spectrum Results im Feld Maximum 
number of list panes den Wert 2.

b Klicken Sie im Fenster Compound List 
auf das Symbol Hide Empty Columns.

c Klicken Sie im Fenster Data Navigator 
auf die erste Verbindung. 

d Wenn das Fenster Data Navigator 
ausgewählt ist, wechseln Sie die 
Verbindungen mit den Pfeiltasten. 

• Die Anzeige beider Spektren ist eine 
komfortable Möglichkeit, alle 
Informationen für eine einzelne 
Verbindung anzuzeigen.

• Beachten Sie, dass sowohl das 
bereinigte als auch das unbereinigte 
Spektrum angezeigt wird.

Aufgabe 12. Verbindungen durch Chromatogrammdekonvolution finden (GC/MS)

Schritt Ausführliche Anweisungen Anmerkungen
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Finden und identifizieren 2
Aufgabe 12. Verbindungen durch Chromatogrammdekonvolution finden
Abb. 31 Ergebnisse des Findens von Verbindungen durch Chromatogrammdekonvolution

Aufgabe 12. Verbindungen durch Chromatogrammdekonvolution finden (GC/MS)

Schritt Ausführliche Anweisungen Anmerkungen
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2 Finden und identifizieren
Aufgabe 13. Verbindungen mit dem Search Library-Algorithmus identifizieren
Aufgabe 13. Verbindungen mit dem Search Library-Algorithmus 
identifizieren

In dieser Aufgabe identifizieren Sie die in „Aufgabe 12. Verbindungen durch 
Chromatogrammdekonvolution finden“ auf Seite 52 gefundenen Verbindungen 
und erzeugen Formeln für sie. Sie können diese Aufgabe ausführen, wenn Sie 
die Bibliothek NIST08.l erworben haben oder die Bibliothek demo.l 
verwenden. Wenn Sie zwei Bibliotheken besitzen, können Sie auch beide 
Bibliotheken auswählen.
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Finden und identifizieren 2
Aufgabe 13. Verbindungen mit dem Search Library-Algorithmus identifizieren
Aufgabe 13. Verbindungen mit dem Search Library-Algorithmus identifizieren

Schritt Ausführliche Anweisungen Anmerkungen

1 Führen Sie eine Bibliothekssuche 
aller Verbindungen in der 
Datendatei 
MSD_mix_4stds_DG_spl200_03.d 
durch.

a Markieren Sie im Fenster Data 
Navigator die Verbindungen in der 
Datendatei 
MSD_mix_4stds_DG_spl200_03.D.

b Klicken Sie im Fenster Method 
Explorer auf Identify Compounds > 
Search Unit Mass Library.

c Klicken Sie in der Registerkarte 
Settings auf die Schaltfläche Add 
Library. Wählen Sie die Bibliothek 
demo.l und klicken Sie auf die 
Schaltfläche OK.

d (Optional) Klicken Sie in der 
Registerkarte Settings auf die 
Schaltfläche Add Library. Wählen Sie 
die Bibliothek NIST08.l und klicken Sie 
auf die Schaltfläche OK.

e Klicken Sie auf die Registerkarte 
Search Results.

f (Optional) Wählen Sie Stop When 
Found als Multi-Library search type.

g Klicken Sie im Hauptmenü auf Identify 
> Search Library for Compounds. 
Stattdessen können Sie auf das 
Symbol Search Library for 
Compounds  klicken, um den 
Algorithmus auszuführen.

h Klicken Sie auf View > Difference 
Results.

i Klicken Sie auf View > Structure 
Viewer.

j Klicken Sie ggf. auf View > Compound 
Identification Results, um dieses 
Fenster anzuzeigen.

k Klicken Sie ggf. auf den Tab für das 
Fenster Compound Identification 
Results. Dieses Fenster und das 
Fenster Chromatogram Results sind 
übereinander gelegt.

• Sie können auch im Method 
Explorer auf GC/Q-TOF Compound 
Screening > Identify by Library 
Search klicken. Derselbe Abschnitt 
wird im Fenster Method Editor 
angezeigt.

• Demo.l und Nist08 sollten im Ordner 
\MassHunter\Library installiert 
sein.

• Beachten Sie, dass viele 
Verbindungen nach Durchsuchen 
der Bibliothek NIST08.l identifiziert 
werden.

• Wenn Sie die Bibliothek NIST08.l 
nicht besitzen, wählen Sie eine 
zweite Bibliothek, falls Sie eine zur 
Verfügung haben.

• Wenn Sie mindestens zwei 
Bibliotheken ausgewählt haben und 
Stop When Found wählen, 
durchsucht der 
Bibliothekssuchalgorithmus die 
erste Bibliothek in der Liste. Wird 
die Verbindung identifiziert, stoppt 
er. Wird die Verbindung nicht 
identifiziert, durchsucht er die 
nächste Bibliothek, bis die 
Verbindung identifiziert oder die 
letzte Bibliothek durchsucht ist.

• Mit dem Programm Library Editor 
ändern Sie Bibliotheken, die Sie mit 
dem Algorithmus Search Unit Mass 
Library verwenden. Dieses 
Programm wird mit dem Programm 
Agilent MassHunter Quantitative 
Analysis installiert. Zum Starten 
dieses Programms klicken Sie auf 
das Symbol .
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2 Finden und identifizieren
Aufgabe 13. Verbindungen mit dem Search Library-Algorithmus identifizieren
2 Zeigen Sie die Spalte Spectral 
Library Results im Fenster 
Compound List und Compound 
Identification Results an.

a Klicken Sie in den Symbolleisten 
Compound List und Compound 
Identification Results auf die 
Schaltfläche Show Library Search 
Columns ( ).

b Klicken Sie in den Symbolleisten 
Compound List und Compound 
Identification Results auf die 
Schaltfläche Hide Empty Columns 
( ).

Abb. 32 Verbindungen in der Datendatei MSD_mix_4stds_DG_spl200_03.D und die Ergebnisse der 
Bibliothekssuche

Aufgabe 13. Verbindungen mit dem Search Library-Algorithmus identifizieren

Schritt Ausführliche Anweisungen Anmerkungen
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Finden und identifizieren 2
Aufgabe 13. Verbindungen mit dem Search Library-Algorithmus identifizieren
3 Wechseln Sie zur Compound 
Details View, um die Verbindungen 
zu prüfen.

a Klicken Sie in der Hauptsymbolleiste 
auf .

b Schließen Sie das Fenster Compound 
Fragment Spectrum Results.

4 Prüfen Sie die Ergebnisse in der 
Compound Details View.

a Klicken Sie im Fenster Compound 
Chromatogram Results auf das Symbol 
Overlaid.

b Blenden Sie die Ergebnisse im Fenster 
Compound Identification Results ein.

• Weitere Informationen zur 
Compound Details View finden Sie 
in der Online-Hilfe. Die Compound 
Details View ist sehr hilfreich, wenn 
Sie die Ergebnisse des Find by 
Formula-Algorithmus mit einer im 
All Ions-Modus erfassten 
Datendatei betrachten.

Abb. 33 Compound Details View mit Verbindungen in Datendatei MSD_mix_4stds_DG_spl200_03.D

Aufgabe 13. Verbindungen mit dem Search Library-Algorithmus identifizieren

Schritt Ausführliche Anweisungen Anmerkungen
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2 Finden und identifizieren
Aufgabe 13. Verbindungen mit dem Search Library-Algorithmus identifizieren
5 Wechseln Sie wieder zur Navigator 
View.

• Klicken Sie in der Hauptsymbolleiste 
auf die Schaltfläche 

.

6 Schließen Sie die Datendatei. a Klicken Sie auf File > Close Data File.
b Klicken Sie auf No.

• Wenn Sie diese Ergebnisse 
speichern möchten, siehe „Aufgabe 
17. Ergebnisse speichern“ auf 
Seite 74.

Aufgabe 13. Verbindungen mit dem Search Library-Algorithmus identifizieren

Schritt Ausführliche Anweisungen Anmerkungen
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Finden und identifizieren 2
Aufgabe 14. Verbindungen finden durch MRM (nur MRM)
Aufgabe 14. Verbindungen finden durch MRM (nur MRM)

Der Find Compounds by MRM-Algorithmus identifiziert Verbindungen in 
MRM-Daten aus einem Triple-Quadrupol. Der Algorithmus sucht mithilfe der 
MRM-Übergänge nach Verbindungen. Alle Verbindungen in der 
Erfassungsmethode werden extrahiert und in der Compound List angezeigt. 
Verbindungen werden nicht auf Basis der Ergebnisse der 
Chromatogrammintegration eliminiert. Sie können den Find Compounds by 
MRM-Algorithmus nur auf Daten anwenden, die mit MRM-Übergängen erfasst 
wurden. Der MRM-Algorithmus nutzt Informationen, die in der Datendatei 
vorliegen, wenn die Datendatei eine MRM-Datendatei ist.

Aufgabe 14. Verbindungen finden durch MRM (nur MRM)

Schritt Ausführliche Anweisungen Anmerkungen

1 Öffnen Sie das TIC für die 
Datendatei Pest - STD 200 MRM.d.

a Wenn das Programm nicht geöffnet 
ist, doppelklicken Sie auf das Symbol 
MassHunter Qualitative Analysis. 
Klicken Sie andernfalls auf File > Open 
Data File.

b Klicken Sie im 
GC-Beispieldatendatei-Ordner auf die 
Datendatei Pest - STD 200 MRM.d.

c Deaktivieren Sie das Kontrollkästchen 
Load result data und klicken Sie auf 
Open.

• Beim Arbeiten mit GC/QQQ-Daten 
verwenden Sie den allgemeinen 
Arbeitsablauf. Beim Arbeiten mit 
GC/Q-TOF-Daten können Sie 
entweder den allgemeinen 
Arbeitsablauf oder den GC/Q-TOF 
Compound Screening-Arbeitsablauf 
verwenden.

Abb. 34 TIC-Chromatogramm aus Pest - STD 200 MRM.d

2 Konfigurieren Sie die 
Benutzeroberfläche zum Einsatz 
mit GC-Daten.

• Folgen Sie den Anweisungen in 
„Aufgabe 2. Benutzeroberfläche für 
GC/MS-Daten konfigurieren“ auf 
Seite 12.
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2 Finden und identifizieren
Aufgabe 14. Verbindungen finden durch MRM (nur MRM)
3 Finden Sie Verbindungen mit dem 
MRM-Algorithmus.

a Wählen Sie im Fenster Method 
Explorer die Option Find Compounds > 
Find by MRM.

b Klicken Sie auf die Schaltfläche Group 
transitions by compound name.

c Klicken Sie auf die Registerkarte 
Integrator.

d Wählen Sie den Integrator Agile.

• Sie können den Bereich des 
Chromatogramms auswählen, wo 
Sie Verbindungen finden möchten. 

• Sie können den gesamten 
Ergebnissatz für eine gefundene 
Verbindung extrahieren, wenn Sie 
die Verbindung markieren und die 
Menüoption Compounds > Extract 
Complete Result Set wählen.

Abb. 35 Registerkarte Integrator im Abschnitt Find by MRM des Method Editor

e Klicken Sie auf , um den Find 
Compounds by MRM-Algorithmus auf 
die Datendatei anzuwenden. 

f Klicken Sie ggf. auf den Befehl View > 
Compound List.

g Klicken Sie ggf. auf den Befehl View > 
Compound Identification Results.

• Das Programm zur qualitativen 
Analyse findet unter diesen 
Bedingungen 28 Verbindungen.

Aufgabe 14. Verbindungen finden durch MRM (nur MRM)

Schritt Ausführliche Anweisungen Anmerkungen
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Finden und identifizieren 2
Aufgabe 14. Verbindungen finden durch MRM (nur MRM)
4 Untersuchen Sie die Verbindungen. 
Siehe Abbildung 36 auf Seite 63.

a Wählen Sie in der Symbolleiste MS 
Spectrum Results im Feld Maximum 
number of list panes den Wert 2.

b Klicken Sie in den Fenstern Compound 
List und Compound Identification 
Results auf das Symbol Automatically 
Show Columns.

c Klicken Sie im Fenster Data Navigator 
auf die erste Verbindung. 

d Wenn das Fenster Data Navigator 
ausgewählt ist, wechseln Sie die 
Verbindungen mit den Pfeiltasten. 

• Das Präkursor-Ion wird in der Spalte 
Precursor (Acq Method) und das 
Produkt-Ion in der Spalte Product 
(Acq Method) im Fenster 
Compound Identification Results 
angezeigt.

Abb. 36 Finden durch MRM-Ergebnisse

Aufgabe 14. Verbindungen finden durch MRM (nur MRM)

Schritt Ausführliche Anweisungen Anmerkungen
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2 Finden und identifizieren
Aufgabe 14. Verbindungen finden durch MRM (nur MRM)
5 Schließen Sie die Datendatei. a Klicken Sie auf File > Close Data File.
b Klicken Sie auf Close.

• Wenn Sie diese Ergebnisse 
speichern möchten, siehe „Aufgabe 
17. Ergebnisse speichern“ auf 
Seite 74.

Aufgabe 14. Verbindungen finden durch MRM (nur MRM)

Schritt Ausführliche Anweisungen Anmerkungen
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Finden und identifizieren 2
Aufgabe 15. Verbindungen durch Integration finden
Aufgabe 15. Verbindungen durch Integration finden

Der Find Compounds by Integration-Algorithmus identifiziert Verbindungen 
auf Basis der Integrationsergebnisse. Eine Verbindung wird für jeden Peak 
erstellt, der vom Integrator identifiziert wird.

Aufgabe 15. Verbindungen durch Integration finden

Schritt Ausführliche Anweisungen Anmerkungen

1 Öffnen Sie das TIC für die Datendatei 
MSD_mix_4stds_DG_spl200_03.d.

a Wenn das Programm nicht geöffnet 
ist, doppelklicken Sie auf das Symbol 
MassHunter Qualitative Analysis. 
Klicken Sie andernfalls auf File > Open 
Data File.

b Klicken Sie im GC-Beispieldatendatei-
Ordner auf die Datendatei Pest - STD 
200 MRM.d.

c Deaktivieren Sie das Kontrollkästchen 
Load result data und klicken Sie auf 
Open.

• Beim Arbeiten mit GC/QQQ-Daten 
verwenden Sie den allgemeinen 
Arbeitsablauf. Beim Arbeiten mit 
GC/Q-TOF-Daten können Sie 
entweder den allgemeinen 
Arbeitsablauf oder den GC/Q-TOF 
Compound Screening-Arbeitsablauf 
verwenden.

Abb. 37 TIC-Chromatogramm aus MSD_mix_4stds_DG_spl200_03.d

2 Konfigurieren Sie die 
Benutzeroberfläche zum Einsatz 
mit GC-Daten.

• Folgen Sie den Anweisungen in 
„Aufgabe 2. Benutzeroberfläche für 
GC/MS-Daten konfigurieren“ auf 
Seite 12.

3 Finden Sie Verbindungen mit dem 
Integrationsalgorithmus.

a Wählen Sie im Fenster Method 
Explorer die Option Find Compounds > 
Find by Integration.

b Wählen Sie den Integrator MS/MS 
(GC).

• Sie können den Bereich des 
Chromatogramms auswählen, wo 
Sie Verbindungen finden möchten. 

• Sie können den gesamten 
Ergebnissatz für eine gefundene 
Verbindung extrahieren, wenn Sie 
die Verbindung markieren und die 
Menüoption Compounds > Extract 
Complete Result Set wählen.
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2 Finden und identifizieren
Aufgabe 15. Verbindungen durch Integration finden
Abb. 38 Registerkarte Integrator im Abschnitt Find by Integration des Method Editor

c Klicken Sie auf , um den Find 
Compounds by Integration-
Algorithmus auf die Datendatei 
anzuwenden. 

d Klicken Sie ggf. auf den Befehl View > 
Compound List.

• Das Programm zur qualitativen 
Analyse findet unter diesen 
Bedingungen 6 Verbindungen.

4 Untersuchen Sie die Verbindungen. 
Siehe Abbildung 36 auf Seite 63.

a Wählen Sie in der Symbolleiste MS 
Spectrum Results im Feld Maximum 
number of list panes den Wert 2.

b Klicken Sie im Fenster Compound List 
auf das Symbol Automatically Show 
Columns.

c Klicken Sie im Fenster Data Navigator 
auf die erste Verbindung. 

d Wenn das Fenster Data Navigator 
ausgewählt ist, wechseln Sie die 
Verbindungen mit den Pfeiltasten. 

Aufgabe 15. Verbindungen durch Integration finden

Schritt Ausführliche Anweisungen Anmerkungen
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Finden und identifizieren 2
Aufgabe 15. Verbindungen durch Integration finden
Abb. 39 Finden durch Integrationsergebnisse

5 Schließen Sie die Datendatei. a Klicken Sie auf File > Close Data File.
b Klicken Sie auf Close.

• Wenn Sie diese Ergebnisse 
speichern möchten, siehe „Aufgabe 
17. Ergebnisse speichern“ auf 
Seite 74.

Aufgabe 15. Verbindungen durch Integration finden

Schritt Ausführliche Anweisungen Anmerkungen
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2 Finden und identifizieren
Aufgabe 16. Formeln erzeugen und Bibliothek nach Peak-Spektren durchsuchen
Aufgabe 16. Formeln erzeugen und Bibliothek nach Peak-Spektren 
durchsuchen

In dieser Aufgabe integrieren und extrahieren Sie zuerst Peak-Spektren aus 
einer GC/Q-TOF-Datendatei. Dann erzeugen Sie für jedes der Peak-Spektren 
mögliche Formeln.

Aufgabe 16. Formeln erzeugen und Bibliothek nach Peak-Spektren durchsuchen

Schritt Ausführliche Anweisungen Anmerkungen

1 Öffnen Sie das TIC für die Datendatei 
MSD_mix_4stds_DB_spl200_03.d.

a Wenn das Programm nicht geöffnet 
ist, doppelklicken Sie auf das Symbol 
MassHunter Qualitative Analysis. 
Klicken Sie andernfalls auf File > Open 
Data File.

b Klicken Sie im 
GC-Beispieldatendatei-Ordner auf die 
Datendatei 
MSD_mix_4stds_DB_spl200_03.d.

c Deaktivieren Sie das Kontrollkästchen 
Load result data und klicken Sie auf 
Open.

• Wenn das Kontrollkästchen Load 
result data nicht verfügbar ist, 
wurden keine Ergebnisse in der 
Datendatei gespeichert. 
Anweisungen zum Speichern von 
Ergebnissen siehe „Aufgabe 17. 
Ergebnisse speichern“ auf Seite 74.

2 Integrieren und extrahieren Sie 
Peak-Spektren.

a Klicken Sie im Fenster Method 
Explorer auf den Abschnitt 
Chromatogram > Integrate (MS).

b Klicken Sie auf die Registerkarte Peak 
Filters.

c Klicken Sie auf die Schaltfläche Peak 
height.

d Markieren Sie das Kontrollkästchen 
Relative height.

e Markieren Sie das Kontrollkästchen 
Limit (by height) to the largest und 
geben Sie 4 ein.

f Klicken Sie auf Chromatograms > 
Integrate and Extract Peak Spectra.
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Aufgabe 16. Formeln erzeugen und Bibliothek nach Peak-Spektren durchsuchen
3 Erzeugen Sie Formeln für jedes der 
Peak-Spektren.
• Zeigen Sie die Spectrum 

Identification Results List an.
• Schließen Sie das Fenster MS 

Spectrum Results.

Hinweis: Um dieselben Ergebnisse 
wie in Abb. 41 zu erhalten, achten Sie 
darauf, dass Sie Common organic 
molecules als Isotope model gewählt 
haben.

a Klicken Sie im Fenster Method 
Explorer auf Identify Compounds > 
Generate Formulas.

b Klicken Sie im Fenster Method Editor 
auf die Registerkarte Charge State 
und wählen Sie Common organic 
molecules als Isotope model.

c Markieren Sie im Fenster Data 
Navigator alle Spektren im Abschnitt 
User Spectra.

d Klicken Sie auf den Befehl Identify > 
Generate Formulas from Spectrum 
Peaks oder die Schaltfläche Generate 
Formulas from Spectrum Peaks , 
um den Algorithmus auszuführen.

e Klicken Sie ggf. auf das Symbol 
Spectrum Identification Results  
oder den Befehl View > Spectrum 
Identification Results.

f Klicken Sie in der Symbolleiste des 
Fensters Spectrum Identification 
Results auf die Schaltfläche 
Automatically Show Columns.

g Klicken Sie im Fenster Spectrum 
Identification Results auf das Symbol 
Hide Empty Columns .

h Wählen Sie C6 H13 als bestes 
Ergebnis (Best).

i Blenden Sie die Tabelle für diese 
Zeile ein.

j Schließen Sie das Fenster Method 
Editor.

k Prüfen Sie die Formeln und Ionenarten, 
die über vielen Peaks im Fenster MS 
Spectrum Results angezeigt werden. 
Alle Formeln und Ionenarten haben 
dieselbe Farbe wie das Spektrum.

• Sie können die vorhergesagten 
Isotopenhäufigkeitsverhältnisse im 
Spektrumplot sehen, wenn Sie auf 
das entsprechende m/z zoomen. 
Weitere Informationen finden Sie in 
der Online-Hilfe.

• Das Symbol Run  in der 
Symbolleiste Method Editor 
ermöglicht Ihnen manchmal, eine 
Aktion aus einem Satz möglicher 
Aktionen auszuwählen. 
Beispielsweise sind zwei 
verschiedene Aktionen möglich, 
wenn Sie in diesem Abschnitt auf 
das Symbol Run klicken. Wenn Sie 
auf den Pfeil klicken, wird eine Liste 
möglicher Aktionen angezeigt, und 
Sie können wählen, welche Aktion 
ausgeführt werden soll. Bei 
Auswahl einer anderen Aktion aus 
der Liste ändert sich die 
Standardaktion. Wenn Sie einfach 
auf die Schaltfläche Run klicken, 
wird die Standardaktion ausgeführt.

• Sie können die Breite einer Spalte 
ändern, indem Sie die Linie ziehen, 
die benachbarte Spalten trennt.

• Sie können eine Spalte durch 
Ziehen des Spaltenkopfes 
verschieben.

• Sie können eine Spalte löschen, 
indem Sie in der Tabelle im 
Kontextmenü auf Remove column 
klicken.

Aufgabe 16. Formeln erzeugen und Bibliothek nach Peak-Spektren durchsuchen

Schritt Ausführliche Anweisungen Anmerkungen
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Aufgabe 16. Formeln erzeugen und Bibliothek nach Peak-Spektren durchsuchen
Abb. 40 Formelergebnisse für Peaks 1 bis 4 erzeugen

4 Führen Sie eine Bibliothekssuche 
für die Peak-Spektren 1 bis 4 durch.

a Klicken Sie im Fenster Data Navigator 
auf User Spectra.

b Klicken Sie im Fenster Method 
Explorer auf Identify Compounds > 
Search Unit Mass Library.

c Achten Sie darauf, dass eine gültige 
Bibliothek ausgewählt ist.

d Klicken Sie im Hauptmenü auf 
Identify > Search Library for Spectra.

e Schließen Sie das Fenster Method 
Editor.

• Der Method Editor wird 
automatisch geöffnet, wenn Sie auf 
einen Abschnitt im Method Explorer 
klicken.

Aufgabe 16. Formeln erzeugen und Bibliothek nach Peak-Spektren durchsuchen

Schritt Ausführliche Anweisungen Anmerkungen
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Aufgabe 16. Formeln erzeugen und Bibliothek nach Peak-Spektren durchsuchen
5 Ändern Sie die sichtbaren Spalten. a Klicken Sie mit der rechten Maustaste 
auf das Fenster Spectrum 
Identification Results und klicken Sie 
auf Add/Remove Columns. Markieren 
Sie im Dialogfeld (Enhanced) 
Add/Remove Columns die Spalten, die 
Sie anzeigen möchten. Klicken Sie auf 
OK.

b Schließen Sie das Fenster Method 
Editor.

c Klicken Sie im Fenster Spectrum 
Identification Results auf das Symbol 
Hide Empty Columns .

d Prüfen Sie die Formeln und Ionenarten, 
die über jedem Peak im Fenster MS 
Spectrum Results angezeigt werden.

• Wenn Sie den Befehl Remove 
Column verwenden und eine Daten 
enthaltende Spalte entfernen, zeigt 
die Software diese Spalte 
automatisch neu an, wenn die 
Funktion Automatically Show 
Columns aktiviert ist.

• Der LibSearch-Algorithmus wird im 
Abschnitt Combine Identification 
Results der Methode stark 
gewichtet. Sie können das beste 
MFG-Ergebnis manuell wählen oder 
die Art ändern, in der 
Identifizierungsergebnisse 
kombiniert werden.

Aufgabe 16. Formeln erzeugen und Bibliothek nach Peak-Spektren durchsuchen

Schritt Ausführliche Anweisungen Anmerkungen
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Aufgabe 16. Formeln erzeugen und Bibliothek nach Peak-Spektren durchsuchen
Abb. 41 Ergebnisse für Bibliothekssuche und Erzeugen von Formeln für die ersten Peak-Spektren

6 Prüfen Sie die Ergebnisse für jedes 
Spektrum im Fenster MS Peaks 
One.

a Klicken Sie auf View > MS Spectrum 
Peak List 1.

b Klicken Sie mit der rechten Maustaste 
und klicken Sie auf Add/Remove 
Columns.

c Achten Sie darauf, dass die in Abb. 42 
gezeigten Spalten in der Liste Show 
these columns enthalten sind.

d Sortieren Sie nach der Spalte Ion Type.
e Wenn Ion Type den Inhalt Fragment 

Ion hat, werden die Formula & Ion 
Species im Fenster MS Spectrum 
Results in Grün über jedem Peak 
angezeigt.

• Die Fragmentionen werden im 
Fenster MS Spectrum Results in 
Grün angezeigt

• Ion Type kann den Inhalt Molecular 
Ion oder Fragment Ion haben oder 
leer sein. Im Falle von Fragment Ion 
zeigen die Spalten Loss Formula 
und Loss Mass die Formeln und 
Masse an, mit denen vom 
Molekular-Ion aus dieses Ion 
ermittelt wird. Die Spalte Formula & 
Ion Species zeigt die Formeln und 
Ionenarten für dieses Ion an.

Aufgabe 16. Formeln erzeugen und Bibliothek nach Peak-Spektren durchsuchen

Schritt Ausführliche Anweisungen Anmerkungen
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Aufgabe 16. Formeln erzeugen und Bibliothek nach Peak-Spektren durchsuchen
Abb. 42 Tabelle MS Peaks One mit den Spalten Ion Type, Loss Formula, Loss Mass 
und Formula & Ion Species

7 (Optional) Schließen Sie die 
Datendatei.
• Sie können mit der nächsten 

Aufgabe fortfahren, um das 
Speichern von Ergebnissen zu 
lernen.

a Klicken Sie auf File > Close Data File.
b Klicken Sie auf Close.

• Wenn Sie diese Ergebnisse 
speichern möchten, siehe „Aufgabe 
17. Ergebnisse speichern“ auf 
Seite 74.

Aufgabe 16. Formeln erzeugen und Bibliothek nach Peak-Spektren durchsuchen

Schritt Ausführliche Anweisungen Anmerkungen
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Aufgabe 17. Ergebnisse speichern
Aufgabe 17. Ergebnisse speichern

In dieser Aufgabe speichern Sie die Ergebnisse für die aktuelle Datendatei.

Aufgabe 17. Ergebnisse speichern

Schritt Ausführliche Anweisungen Anmerkungen

1 Speichern Sie die Ergebnisse für 
die aktuelle Datendatei und 
schließen Sie die Datei.

a Klicken Sie auf File > Save Results.
b Klicken Sie auf File > Close Data File.

• Sie können nur einen Satz von 
Ergebnissen mit einer Datendatei 
speichern. Wenn Sie bereits 
Ergebnisse mit der aktuellen 
Datendatei gespeichert haben, 
werden diese Ergebnisse 
überschrieben, wenn Sie auf File > 
Save Results klicken.

2 Öffnen Sie die Datendatei und 
laden Sie die Ergebnisse.

a Klicken Sie auf File > Open Data File. 
Das Dialogfeld Open Data File wird 
geöffnet.

b Wählen Sie eine Datendatei. Wählen 
Sie für dieses Beispiel die Datendatei 
MSD_mix_4stds_DG_spl200_03.d.

c Markieren Sie das Kontrollkästchen 
Load result data.

d Klicken Sie auf die Schaltfläche Open.
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Aufgabe 17. Ergebnisse speichern
Abb. 43 Dialogfeld Open Data File

3 Untersuchen Sie die Ergebnisse. a Klicken Sie auf das Fenster Spectrum 
Identification Results.

b Prüfen Sie die Ergebnisse.

•

Aufgabe 17. Ergebnisse speichern

Schritt Ausführliche Anweisungen Anmerkungen

Das Kontrollkästchen Load result data ist markiert.
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Aufgabe 17. Ergebnisse speichern
Abb. 44 Ergebnisse für Bibliothekssuche und Erzeugen von Formeln für die ersten Peak-Spektren

4 Schließen Sie die Datendatei. a Klicken Sie auf File > Close Data File.
b Klicken Sie auf Close.

5 Öffnen Sie die Datendatei erneut 
und laden Sie die Ergebnisse nicht.

a Klicken Sie auf File > Open. Das 
Dialogfeld Open Data File wird 
geöffnet.

b Wählen Sie eine Datendatei. Wählen 
Sie für dieses Beispiel die Datendatei 
MSD_mix_4stds_DG_spl200_03.d.

c Deaktivieren Sie das Kontrollkästchen 
Load result data.

d Klicken Sie auf die Schaltfläche Open.

• Wenn Sie keine Ergebnisse laden, 
wird standardmäßig ein TIC 
geöffnet, wenn Sie eine Datendatei 
öffnen. Wenn Sie das 
Kontrollkästchen Run ‘File Open’ 
actions from selected method 
markieren, werden stattdessen die 
Dateiöffnungsaktionen ausgeführt. 
Weitere Informationen finden Sie in 
der Online-Hilfe.

Aufgabe 17. Ergebnisse speichern

Schritt Ausführliche Anweisungen Anmerkungen
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Aufgabe 17. Ergebnisse speichern
Abb. 45 Ergebnisse für Bibliothekssuche und Erzeugen von Formeln für die ersten Peak-Spektren

6 Schließen Sie die Datendatei. a Klicken Sie auf File > Close Data File.
b Klicken Sie auf Close.

Aufgabe 17. Ergebnisse speichern

Schritt Ausführliche Anweisungen Anmerkungen
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Aufgabe 17. Ergebnisse speichern
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Agilent MassHunter Workstation Software Qualitative Analyse
Einarbeitungshandbuch
3
Verwenden von Workflows, Exportieren 
und Drucken

Aufgabe 18. Qualitative Analysemethode mithilfe des allgemeinen 
Arbeitsablaufs einrichten und ausführen 80

Aufgabe 19. Methode mithilfe des GC/Q-TOF Compound 
Screening-Arbeitsablaufs einrichten und ausführen 86

Aufgabe 20. CEF-Datei exportieren 90

Aufgabe 21. Analysebericht drucken 92

Aufgabe 22. Verbindungsbericht drucken 95

Im Rahmen dieser Aufgaben lernen Sie, wie Sie eine qualitative 
Analysemethode einrichten und ausführen. Anschließend öffnen Sie eine 
Datendatei, um die Aktionen innerhalb der automatisierten Methode 
auszuführen. 

Für diese Beispiele werden zwei verschiedene Arbeitsabläufe verwendet. 
Weitere Informationen finden Sie unter „Arbeitsabläufe“ auf Seite 109.

Der allgemeine Arbeitsablauf unterstützt GC/QQQ-, GC/Q-TOF- und 
LC/MS-Daten. Der GC/Q-TOF Compound Screening-Arbeitsablauf unterstützt 
GC/Q-TOF-Daten.

Jede Übung wird in einer dreispaltigen Tabelle dargestellt:

• Schritte – Lernen Sie das Programm mit diesen allgemeinen Anweisungen 
selbständig kennen.

• Ausführliche Anweisungen – Verwenden Sie diese, wenn Sie Hilfe benötigen 
oder beim Lernen lieber schrittweise vorgehen möchten.

• Anmerkungen – Hier finden Sie Tipps und weitere Informationen zu den 
einzelnen Übungsschritten.
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3 Verwenden von Workflows, Exportieren und Drucken
Aufgabe 18. Qualitative Analysemethode mithilfe des allgemeinen Arbeitsablaufs einrichten und 
ausführen
Aufgabe 18. Qualitative Analysemethode mithilfe des allgemeinen 
Arbeitsablaufs einrichten und ausführen

Wenn Sie das Programm Qualitative Analyse zum ersten Mal verwenden, wird 
die Methode default.m geladen. Sie können entweder die geöffnete Methode 
ändern und speichern oder aber eine neue Methode öffnen, ändern und 
speichern. Die Methode default.m kann nicht überschrieben werden.

Sie können auch festlegen, beim Öffnen einer Datendatei bestimmte Aktionen 
in der Methode auszuführen. Beim Öffnen einer Datendatei können Sie auch 
die Methode laden, die zum Erstellen der mit der Datendatei gespeicherten 
Ergebnisse verwendet wurde. Diese Methode wird beim Speichern der 
Ergebnisse mit der Datendatei automatisch gespeichert. Der allgemeine 
Arbeitsablauf kann mit GC/MS- oder LC/MS-Datendateien verwendet werden.

Aufgabe 18. Qualitative Analysemethode mithilfe des allgemeinen Arbeitsablaufs einrichten und ausführen

Schritte Ausführliche Anweisungen Anmerkungen

1 Öffnen Sie das TIC für die 
Datendatei Pest - STD 200 MRM.d.

a Wenn das Programm nicht geöffnet 
ist, doppelklicken Sie auf das Symbol 
MassHunter Qualitative Analysis. 
Klicken Sie andernfalls auf File > Open 
Data File.

b Klicken Sie im 
GC-Beispieldatendatei-Ordner auf die 
Datendatei Pest - STD 200 MRM.d.

c Deaktivieren Sie das Kontrollkästchen 
Load result data und klicken Sie auf 
Open.

• Beim Arbeiten mit GC/MS-Daten 
können Sie entweder den 
allgemeinen Arbeitsablauf oder den 
GC/Q-TOF Compound 
Screening-Arbeitsablauf 
verwenden.

2 Konfigurieren Sie die 
Benutzeroberfläche zum Einsatz 
mit GC-Daten.

• Folgen Sie den Anweisungen in 
„Aufgabe 2. Benutzeroberfläche für 
GC/MS-Daten konfigurieren“ auf 
Seite 12.

• Wählen Sie für dieses Beispiel den 
allgemeinen Arbeitsablauf aus.
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Aufgabe 18. Qualitative Analysemethode mithilfe des allgemeinen Arbeitsablaufs einrichten und

ausführen
3 Richten Sie die Methode zum 
Extrahieren eines 
TIC-Chromatogramms ein. 
• Definieren Sie ein 

TIC-Chromatogramm für 
MS-Daten.

a Wählen Sie im Fenster Method 
Explorer die Option Chromatogram > 
Define Chromatograms aus.

b Löschen Sie das BPC-Chromatogram.
c Wählen Sie unter Type die Option TIC 

aus.
d Stellen Sie sicher, dass MS Level auf 

MS/MS gesetzt ist.
e Klicken Sie auf Add.

4 Bearbeiten Sie die Methode, um 
die Daten zu integrieren.
• Beschränken Sie die Integration 

auf die vier höchsten Peaks.

a Klicken Sie im Fenster Method 
Explorer auf Chromatogram > 
Integrate (MS/MS).

b Klicken Sie auf die Registerkarte Peak 
Filters.

c Aktivieren Sie im Bereich Maximum 
number of peaks das Kontrollkästchen 
Limit (by height) to the largest.

d Geben Sie 4 ein. 

• Beim Aktualisieren eines Werts im 
Bereich Chromatogram > Integrate 
(MS) der Registerkarte Peak Filters 
werden automatisch auch Werte in 
anderen Bereichen des Method 
Explorer aktualisiert. Diese 
Bereiche werden mit blauen 
Dreiecken gekennzeichnet.

Abb. 46 Registerkarte Chromatogram > Integrate (MS/MS) > Peak Filters

5 Testen Sie die Integration, um 
sicherzustellen, dass nur 4 
integrierte Peaks angezeigt 
werden.

• Klicken Sie auf das Symbol Integrate 
Chromatogram , um die 
Datendatei zu integrieren. 

Aufgabe 18. Qualitative Analysemethode mithilfe des allgemeinen Arbeitsablaufs einrichten und ausführen

Schritte Ausführliche Anweisungen Anmerkungen

Sie können auf das Symbol 
Save Method klicken, um die 
aktuelle Methode zu 
speichern.
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Aufgabe 18. Qualitative Analysemethode mithilfe des allgemeinen Arbeitsablaufs einrichten und 
ausführen
6 Speichern Sie die Methode unter 
iii_GCexercise1, wobei Sie “iii” 
durch Ihre Initialen ersetzen.

a Klicken Sie im oberen Menü auf 
Method > Save As.

b Geben Sie iii_GCexercise1 ein.
c Klicken Sie auf die Schaltfläche Save.

• Beachten Sie, dass beim Speichern 
der Methode alle blauen Dreiecke, 
die auf Wertänderungen in der 
geöffneten Methode hinweisen, 
verschwinden.

7 Ändern Sie den 
Peak-Spektrumhintergrund, um 
das Spektrum zu verwenden, das 
zu Beginn eines Peaks dargestellt 
wird.

a Klicken Sie im Fenster Method 
Explorer auf Spectrum > Extract 
(MS/MS).

b Klicken Sie auf Peak Spectrum 
Extraction (MS/MS).

c Wählen Sie für den 
Peak-Spektrumhintergrund Spectrum 
at peak start aus.

• Falls Sie nach dem Speichern der 
Methode weitere Änderungen 
vornehmen, werden blaue Dreiecke 
hinzugefügt.

Abb. 47 Registerkarte > Extract (MS/MS) > Peak Spectrum Extraction (MS/MS)

8 Testen Sie die 
MS-Spektrumextraktion, um 
sicherzustellen, dass ein 
Hintergrundspektrum subtrahiert 
wird.

• Klicken Sie auf das Symbol Extract 
Peak Spectrum , um die Aktion für 
den ausgewählten Peak in der 
Datendatei auszuführen. 

Aufgabe 18. Qualitative Analysemethode mithilfe des allgemeinen Arbeitsablaufs einrichten und ausführen

Schritte Ausführliche Anweisungen Anmerkungen

Sie können auf das Symbol 
Save Method klicken, um die 
aktuelle Methode zu 
speichern.
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Aufgabe 18. Qualitative Analysemethode mithilfe des allgemeinen Arbeitsablaufs einrichten und

ausführen
9 Speichern Sie die Methode. • Zum Speichern der Methode stehen 
drei Möglichkeiten zur Verfügung:

•Klicken Sie im Method 
Editor auf das Symbol Save 
Method.

• Klicken Sie mit der rechten 
Maustaste auf den Method Editor, 
und klicken Sie dann auf Save 
Method.

• Klicken Sie im oberen Menü auf 
Method > Save.

• Das Symbol Save Method wird in 
Abbildung 47 auf Seite 82 gezeigt.

10 Richten Sie die Methode so ein, 
dass die Aktionen, deren 
Parameter Sie soeben geändert 
haben, beim Öffnen einer 
Datendatei automatisch 
ausgeführt werden.
• Listen Sie die Aktionen auf, die 

beim Öffnen dieser oder einer 
anderen Datendatei ausgeführt 
werden sollen.

Hinweis: Schauen Sie im Method 
Explorer unter General nach.

a Wählen Sie im Fenster Method 
Explorer die Option General > File 
Open Actions aus.

b Wählen Sie in der Liste Available 
actions die Option Integrate and 
Extract Peak Spectra aus. 

c Klicken Sie auf die Schaltfläche Add 
, um die ausgewählte Aktion in 

die Liste Actions to be run zu 
verschieben. 
Sie können auch auf die ausgewählte 
Aktion doppelklicken, um sie in die 
andere Liste zu verschieben.

11 Testen Sie die unter File Open 
Actions eingerichteten Aktionen.

• Klicken Sie auf das Symbol Run File 
Open Actions Now , um die 
Aktionen für die Datendatei 
auszuführen. 

• Die Chromatogramme und Spektren 
werden nicht überschrieben. Neue 
Chromatogramme und Spektren 
werden hinzugefügt.

Aufgabe 18. Qualitative Analysemethode mithilfe des allgemeinen Arbeitsablaufs einrichten und ausführen

Schritte Ausführliche Anweisungen Anmerkungen
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Aufgabe 18. Qualitative Analysemethode mithilfe des allgemeinen Arbeitsablaufs einrichten und 
ausführen
Abb. 48 Bereich General > File Open Actions im Method Editor

12 Speichern Sie die Methode. • Klicken Sie im Fenster Method Editor 
auf das Symbol Save Method.

13 Richten Sie die Methode so ein, 
dass die Aktionen automatisch 
ausgeführt werden, wenn sie 
während einer Arbeitsliste 
ausgeführt wird.
• Listen Sie die Aktionen auf, die 

beim Öffnen dieser oder einer 
anderen Datendatei ausgeführt 
werden sollen.

Hinweis: Schauen Sie im Fenster 
Method Explorer unter Worklist 
Automation nach.

a Wählen Sie im Fenster Method 
Explorer die Option Worklist 
Automation > Worklist Actions aus.

b Entfernen Sie Generate Analysis 
Report aus der Liste Actions to be run.

14 Testen Sie die unter Worklist 
Actions eingerichteten Aktionen.

• Klicken Sie auf das Symbol Run 
Worklist Actions Now , um die 
Aktionen für die Datendatei 
auszuführen. 

• Die Chromatogramme und Spektren 
werden nicht überschrieben. Neue 
Chromatogramme und Spektren 
werden hinzugefügt.

Aufgabe 18. Qualitative Analysemethode mithilfe des allgemeinen Arbeitsablaufs einrichten und ausführen

Schritte Ausführliche Anweisungen Anmerkungen

Die Liste Actions to be run enthält 
zwei verschiedene Aktionen. 
Die erste Aktion dient zum 
Extrahieren der definierten 
Chromatogramme. Anschließend 
wird das betreffende 
Chromatogramm integriert und 
Peaks werden extrahiert.
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Aufgabe 18. Qualitative Analysemethode mithilfe des allgemeinen Arbeitsablaufs einrichten und

ausführen
Abb. 49 Bereich Worklist Automation > Worklist Actions im Method Editor

15 Speichern Sie die Methode, und 
schließen Sie die Datendatei, ohne 
die Ergebnisse zu speichern.

a Klicken Sie im Method Editor auf das 
Symbol Save Method.

b Klicken Sie auf File > Close Data File. 
Wenn Sie zum Speichern der 
Ergebnisse aufgefordert werden, 
klicken Sie auf No.

Aufgabe 18. Qualitative Analysemethode mithilfe des allgemeinen Arbeitsablaufs einrichten und ausführen

Schritte Ausführliche Anweisungen Anmerkungen

Eine Methode enthält zwei 
verschiedene Aktionslisten. Die 
erste Aktionsliste (File Open 
Actions) kann beim Öffnen einer 
Datendatei ausgeführt werden. 
Die zweite Aktionsliste (Worklist 
Actions) wird beim Ausführen der 
Methode ausgeführt.
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Aufgabe 19. Methode mithilfe des GC/Q-TOF Compound 
Screening-Arbeitsablaufs einrichten und ausführen

Im Rahmen dieser Aufgabe richten Sie eine qualitative Analysemethode ein, 
die eine Liste von Analyseaktionen enthält, welche in einer bestimmten 
Reihenfolge ausgeführt werden sollen. Dazu gehören das Extrahieren und 
Integrieren von Chromatogrammen, das Extrahieren von Spektren, das 
Suchen einer Bibliothek für Peak-Spektren, das Generieren von Formeln für 
Spektren sowie das Drucken eines Analyseberichts.

Aufgabe 19. Methode mithilfe des GC/Q-TOF Compound Screening-Arbeitsablaufs einrichten und ausführen

Schritte Ausführliche Anweisungen Anmerkungen

1 Öffnen Sie das TIC für die Datendatei 
MSD_mix_4stds_DG_spl200_03.d.

a Wenn das Programm nicht geöffnet 
ist, doppelklicken Sie auf das Symbol 
MassHunter Qualitative Analysis. 
Klicken Sie andernfalls auf File > Open 
Data File.

b Klicken Sie im 
GC-Beispieldatendatei-Ordner auf die 
Datendatei 
MSD_mix_4stds_DG_spl200_03.d.

c Deaktivieren Sie das Kontrollkästchen 
Load result data und klicken Sie auf 
Open.

2 Konfigurieren Sie die 
Benutzeroberfläche zum Einsatz 
mit GC-Daten.

• Folgen Sie den Anweisungen in 
„Aufgabe 2. Benutzeroberfläche für 
GC/MS-Daten konfigurieren“ auf 
Seite 12.

• Wählen Sie für dieses Beispiel den 
GC/Q-TOF Compound 
Screening-Arbeitsablauf aus.

3 Stellen Sie sicher, dass ein TIC 
extrahiert wird. 

a Wählen Sie im Fenster Method 
Explorer die Option Chromatogram 
aus.

b Klicken Sie auf den Bereich Define 
Chromatograms.

c Überprüfen Sie im Method Editor, ob 
es sich bei dem Chromatogramm im 
Bereich Defined chromatograms um 
ein TIC handelt. Falls nicht, wählen Sie 
unter Type die Option TIC aus. Klicken 
Sie auf die Schaltfläche Change.

•
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ausführen
4 Überprüfen Sie die Parameter für 
den Algorithmus Find by 
Chromatogram Deconvolution.

a Klicken Sie im Fenster Method 
Explorer auf den Bereich GC/Q-TOF 
Compound Screening > Find by 
Chromatogram Deconvolution.

b Klicken Sie auf die Registerkarte Mass 
Filter.

c Setzen Sie den Wert Absolute height 
auf 13000.

d Klicken Sie auf die Registerkarte 
Results.

e Klicken Sie auf die Schaltfläche 
Highlight all compounds.

f Überprüfen Sie die Ergebnisse auf den 
einzelnen Registerkarten.

• Sehen Sie sich die Bereiche für den 
GC/Q-TOF Compound 
Screening-Arbeitsablauf an.

• Beachten Sie die sechs Bereiche in 
diesem Arbeitsablauf. Alle diese 
Bereiche sind Duplikate der 
Bereiche, die bereits im Method 
Explorer enthalten sind.

• Beachten Sie, dass in anderen 
Bereichen des Method Explorer 
blaue Dreiecke angezeigt werden. 
Diese Dreiecke weisen darauf hin, 
dass dieselben Parameterwerte 
auch an anderer Stelle geändert 
wurden.

5 Überprüfen Sie die Parameter für 
den Algorithmus Identify by Library 
Search.

a Klicken Sie im Fenster Method 
Explorer auf den Bereich GC/Q-TOF 
Compound Screening > Identify by 
library search.

b Klicken Sie auf die Schaltfläche Add 
Library. Wählen Sie eine Bibliothek 
aus, und klicken Sie auf Open.

c (optional) Zum Entfernen einer nicht 
benötigten Bibliothek klicken Sie auf 
die Schaltfläche Remove Library.

d Überprüfen Sie die Parameter auf den 
einzelnen Registerkarten.

• Im Ordner \MassHunter\Library ist 
entweder die Bibliothek 
demo.l library oder die Bibliothek 
NIST08.l (bzw. eine andere Version 
der NIST-Bibliothek) installiert.

6 Speichern Sie die Methode unter 
iii_GCexercise2, wobei Sie “iii” 
durch Ihre Initialen ersetzen.

a Klicken Sie im oberen Menü auf 
Method > Save As.

b Geben Sie iii_GCexercise2 ein.
c Klicken Sie auf die Schaltfläche Save.

Aufgabe 19. Methode mithilfe des GC/Q-TOF Compound Screening-Arbeitsablaufs einrichten und ausführen

Schritte Ausführliche Anweisungen Anmerkungen
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7 Richten Sie die Methode so ein, 
dass die Aktionen beim Öffnen 
einer Datendatei automatisch 
ausgeführt werden.
• Listen Sie die Aktionen auf, die 

beim Öffnen dieser oder einer 
anderen Datendatei ausgeführt 
werden sollen.

Hinweis: Schauen Sie im Fenster 
Method Explorer unter General nach.

a Wählen Sie im Fenster Method 
Explorer die Option General > File 
Open Actions aus.

b Entfernen Sie Generate Analysis 
Report aus der Liste Actions to be run.

c Entfernen Sie Integrate and Extract 
Peak Spectra.

d Entfernen Sie ggf. andere Aktionen 
aus der Liste.

e Fügen Sie Extract Defined 
Chromatograms hinzu.

f Fügen Sie Find Compounds by 
Chromatographic Deconvolution 
hinzu.

g Fügen Sie Search Spectral Library for 
Compound hinzu.

8 Testen Sie die unter File Open 
Actions eingerichteten Aktionen.

• Klicken Sie auf das Symbol Run File 
Open Actions Now , um die 
Aktionen für die Datendatei 
auszuführen. 

• Die Chromatogramme und Spektren 
werden nicht überschrieben. Neue 
Chromatogramme und Spektren 
werden hinzugefügt.

Aufgabe 19. Methode mithilfe des GC/Q-TOF Compound Screening-Arbeitsablaufs einrichten und ausführen

Schritte Ausführliche Anweisungen Anmerkungen
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ausführen
Abb. 50 Ergebnisse ausgeführter Arbeitslistenaktionen für die GC/Q-TOF-Daten

9 Speichern Sie die Methode unter 
iii_GCexercise2, wobei Sie “iii” 
durch Ihre Initialen ersetzen.

a Klicken Sie im Menü auf Method > 
Save As.

b Geben Sie iii_GCexercise2 ein.
c Klicken Sie auf Save.

• Falls diese Methode während einer 
Data Acquisition-Arbeitsliste 
ausgeführt wird, werden die 
Arbeitslistenaktionen auf dieser 
Registerkarte in der angegebenen 
Reihenfolge ausgeführt.

10 Schließen Sie die Datendatei, ohne 
die Ergebnisse zu speichern.

a Klicken Sie auf File > Close Data File.
b Wenn Sie zum Speichern der 

Ergebnisse aufgefordert werden, 
klicken Sie auf No.

Aufgabe 19. Methode mithilfe des GC/Q-TOF Compound Screening-Arbeitsablaufs einrichten und ausführen

Schritte Ausführliche Anweisungen Anmerkungen
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Aufgabe 20. CEF-Datei exportieren

Sie können eine CEF-Datei mit Verbindungsinformationen exportieren. Diese 
CEF-Datei kann in andere Programme wie MassHunter Quantitative Analysis 
und Mass Profiler Professional importiert werden. Sie können auch 
Verbindungen importieren, die in eine CEF-Datei exportiert wurden.

Aufgabe 20. CEF-Datei exportieren

Schritte Ausführliche Anweisungen Anmerkungen

1 Öffnen Sie die Datendatei 
MSD_mix_4stds_DG_spl200_03.d
, und führen Sie die unter File Open 
Actions eingerichteten Aktionen 
für die Methode iii_GCexercise2.m 
aus, die in „Aufgabe 19. Methode 
mithilfe des GC/Q-TOF Compound 
Screening-Arbeitsablaufs 
einrichten und ausführen“ auf 
Seite 86 erstellt wurde.

a Wenn das Programm nicht geöffnet 
ist, doppelklicken Sie auf das Symbol 
MassHunter Qualitative Analysis. 
Klicken Sie andernfalls auf File > Open 
Data File.

b Klicken Sie im 
GC-Beispieldatendatei-Ordner auf die 
Datendatei 
MSD_mix_4stds_DG_spl200_03.d.

c Deaktivieren Sie das Kontrollkästchen 
Load result data.

d Aktivieren Sie das Kontrollkästchen 
Run File Open actions from selected 
method.

e Klicken Sie auf die Schaltfläche Use 
current method und dann auf Open.

• Wenn Sie „Aufgabe 19. Methode 
mithilfe des GC/Q-TOF Compound 
Screening-Arbeitsablaufs einrichten 
und ausführen“ auf Seite 86 
abgeschlossen haben, lautet die 
aktuelle Methode 
iii_GCexercise2.m. Diese Methode 
ist so eingerichtet, dass zunächst 
der Algorithmus Find Compounds by 
Chromatogram Deconvolution und 
dann für jede Verbindung der 
Algorithmus Search Library 
ausgeführt wird.

2 Exportieren Sie eine CEF-Datei. a Zum interaktiven Exportieren der Datei 
klicken Sie auf File > Export > as CEF.

b Klicken Sie auf die Schaltfläche All 
results.

c Wählen Sie den Speicherort der 
Exportdatei aus.

d Klicken Sie auf OK.

• Eine CEF-Datei wird zum 
Exportieren von Verbindungen 
verwendet. 
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Aufgabe 20. CEF-Datei exportieren
Abb. 51 Dialogfeld Export CEF Options

Aufgabe 20. CEF-Datei exportieren (Fortsetzung)

Schritte Ausführliche Anweisungen Anmerkungen
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Aufgabe 21. Analysebericht drucken

Wenn Sie einen Analysebericht drucken möchten, nachdem Sie die Aufgaben 
in dieser oder der nächsten Übung ausgeführt haben, befolgen Sie diese 
Anweisungen. 

Ein Analysebericht kann die Ergebnisse von Aktionen wie dem Extrahieren 
und Integrieren von Chromatogrammen, dem Extrahieren von Spektren, der 
Suche nach einer Bibliothek für Peak-Spektren und dem Generieren von 
Formeln für Spektren enthalten. 

Aufgabe 21. Analysebericht drucken

Schritte Ausführliche Anweisungen Anmerkungen

1 Wenn die Datendatei 
MSD_mix_4stds_DG_spl200_03.d 
nicht geladen ist, öffnen Sie diese 
und führen Sie die unter File Open 
Actions eingerichteten Aktionen 
für die Methode iii_GCexercise2.m 
aus, die in „Aufgabe 19. Methode 
mithilfe des GC/Q-TOF Compound 
Screening-Arbeitsablaufs 
einrichten und ausführen“ auf 
Seite 86 erstellt wurde.

a Wenn das Programm nicht geöffnet 
ist, doppelklicken Sie auf das Symbol 
MassHunter Qualitative Analysis. 
Klicken Sie andernfalls auf File > Open 
Data File.

b Klicken Sie im 
GC-Beispieldatendatei-Ordner auf die 
Datendatei 
MSD_mix_4stds_DG_spl200_03.d.

c Deaktivieren Sie das Kontrollkästchen 
Load result data.

d Aktivieren Sie das Kontrollkästchen 
Run File Open actions from selected 
method.

e Klicken Sie auf die Schaltfläche Use 
current method und dann auf Open.

• Wenn Sie „Aufgabe 19. Methode 
mithilfe des GC/Q-TOF Compound 
Screening-Arbeitsablaufs einrichten 
und ausführen“ auf Seite 86 
abgeschlossen haben, lautet die 
aktuelle Methode 
iii_GCexercise2.m. Diese Methode 
ist so eingerichtet, dass zunächst 
der Algorithmus Find Compounds by 
Chromatogram Deconvolution und 
dann für jede Verbindung der 
Algorithmus Search Library 
ausgeführt wird.

2 Ändern Sie die Auswahl der 
Analyseberichte in der Methode:
• Aktivieren Sie die 

Kontrollkästchen für die 
Chromatogramm, Spektren oder 
Tabellen, die gedruckt werden 
sollen.

• Deaktivieren Sie die 
Kontrollkästchen für die 
Chromatogramm, Spektren oder 
Tabellen, die nicht gedruckt 
werden sollen.

a Klicken Sie im Fenster Method 
Explorer auf Reports > Analysis 
Report.

b Aktivieren Sie die Kontrollkästchen für 
alle weiteren Elemente, die gedruckt 
werden sollen.

c Deaktivieren Sie die ausgewählten 
Chromatogramme und Spektren, die 
nicht gedruckt werden sollen.

• Der Analysebericht enthält nur die 
Informationen, die Sie in diesem 
Bereich auswählen. 

• Elemente, für die keine Ergebnisse 
verfügbar sind, werden nicht in den 
Bericht aufgenommen, auch wenn 
sie in diesem Bereich ausgewählt 
wurden. Wenn Sie beispielsweise 
das Chromatogramm nicht 
integriert haben, wird die 
Peak-Tabelle nicht in den Bericht 
aufgenommen.
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Aufgabe 21. Analysebericht drucken
Abb. 52 Bereich Analysis Report in den Fenstern Method Explorer und Method Editor

3 Drucken Sie den Bericht. a Zum interaktiven Drucken des Berichts 
stehen mehrere Möglichkeiten zur 
Verfügung:
• Klicken Sie im Hauptmenü auf File > 

Print > Analysis Report.
• Klicken Sie in der Hauptsymbolleiste 

auf das Druckersymbol.
• Klicken Sie nach Auswahl des 

Bereichs Analysis Report in der 
Symbolleiste des Method Editor auf 
das Symbol Print Analysis Report 

.
• Klicken Sie im Method Editor mit der 

rechten Maustaste auf den Bereich 
Analysis Report, und wählen Sie 
dann Print Analysis Report.

• Klicken Sie im Data Navigator im 
Datendatei-Kontextmenü auf 
Analysis Report.

b Klicken Sie auf Report contents.
c Aktivieren Sie das Kontrollkästchen 

Print report, und wählen Sie einen 
Drucker aus.

d Aktivieren Sie das Kontrollkästchen 
Print preview.

e Klicken Sie auf die Schaltfläche OK.

• Das Symbol Run  in der 
Symbolleiste Method Editor 
ermöglicht Ihnen manchmal, eine 
Aktion aus einem Satz möglicher 
Aktionen auszuwählen. Wenn Sie 
beispielsweise zum Bereich Reports 
> Common Reporting Options des 
Fensters Method Editor wechseln, 
sind vier verschiedene Aktionen 
möglich, wenn Sie auf das Symbol 
Run klicken. Wenn Sie auf den Pfeil 
klicken, wird eine Liste möglicher 
Aktionen angezeigt, und Sie können 
wählen, welche Aktion ausgeführt 
werden soll. Bei Auswahl einer 
anderen Aktion aus der Liste ändert 
sich die Standardaktion. Wenn Sie 
einfach auf die Schaltfläche Run 
klicken, wird die Standardaktion 
ausgeführt.

Aufgabe 21. Analysebericht drucken (Fortsetzung)

Schritte Ausführliche Anweisungen Anmerkungen

Das Fenster Method Editor ist 
standardmäßig frei beweglich. Es 
wird als separates Fenster getrennt 
vom übrigen Programm zur 
qualitativen Analyse angezeigt. Zum 
Verankern des Fensters klicken Sie 
mit der rechten Maustaste auf den 
Titel des Fensters und wählen dann 
Floating. Sie können auch auf die 
Titelleiste doppelklicken, um das 
Fenster zu verankern.
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Aufgabe 21. Analysebericht drucken
Abb. 53 Dialogfeld Print Analysis Report

f Überprüfen Sie den Bericht.
g Klicken Sie in der Symbolleiste auf das 

Symbol Close Print Preview.

Abb. 54 Fenster Print Preview mit Analysebericht

Aufgabe 21. Analysebericht drucken (Fortsetzung)

Schritte Ausführliche Anweisungen Anmerkungen
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Aufgabe 22. Verbindungsbericht drucken

Zum Drucken eines Verbindungsberichts befolgen Sie diese Anweisungen.

Aufgabe 22. Verbindungsbericht drucken

Schritt Ausführliche Anweisungen Anmerkungen

1 Wenn die Datendatei 
MSD_mix_4stds_DG_spl200_03.d 
nicht geladen ist, öffnen Sie diese 
und führen Sie die unter File Open 
Actions eingerichteten Aktionen 
für die Methode iii_GCexercise2.m 
aus, die in „Aufgabe 19. Methode 
mithilfe des GC/Q-TOF Compound 
Screening-Arbeitsablaufs 
einrichten und ausführen“ auf 
Seite 86 erstellt wurde.

a Wenn das Programm nicht geöffnet 
ist, doppelklicken Sie auf das Symbol 
MassHunter Qualitative Analysis. 
Klicken Sie andernfalls auf File > Open 
Data File.

b Klicken Sie im 
GC-Beispieldatendatei-Ordner auf die 
Datendatei 
MSD_mix_4stds_DG_spl200_03.d.

c Deaktivieren Sie das Kontrollkästchen 
Load result data.

d Aktivieren Sie das Kontrollkästchen 
Run File Open actions from selected 
method.

e Klicken Sie auf die Schaltfläche Use 
current method und dann auf Open.

• Wenn Sie „Aufgabe 19. Methode 
mithilfe des GC/Q-TOF Compound 
Screening-Arbeitsablaufs einrichten 
und ausführen“ auf Seite 86 
abgeschlossen haben, lautet die 
aktuelle Methode 
iii_GCexercise2.m. Diese Methode 
ist so eingerichtet, dass zunächst 
der Algorithmus Find Compounds by 
Chromatogram Deconvolution und 
dann für jede Verbindung der 
Algorithmus Search Library 
ausgeführt wird.

2 Ändern Sie die Auswahl der 
Verbindungsberichte in der 
Methode:
• Deaktivieren Sie die vergrößerte 

Anzeige von MS-Spektren für 
besondere Peaks.

• Deaktivieren Sie die 
MS/MS-Optionen im Bericht.

a Klicken Sie im Method Explorer auf 
Reports > Compound Report.

b Deaktivieren Sie das Kontrollkästchen 
Show MS spectrum.

c Deaktivieren Sie das Kontrollkästchen 
Show MS/MS spectrum.

d Deaktivieren Sie das Kontrollkästchen 
Show MS/MS peak table.

• Über diese Kontrollkästchen können 
Sie festlegen, welche Informationen 
ggf. in einen Bericht aufgenommen 
werden sollen. Falls die 
Informationen nicht verfügbar sind, 
wird der betreffende Bereich 
automatisch übersprungen. 
Beispielsweise werden 
MS/MS-Ergebnisse nicht 
aufgenommen, wenn die 
Datendatei nur MS-Daten enthält.
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Aufgabe 22. Verbindungsbericht drucken
Abb. 55 Klicken Sie im Method Editor auf den Bereich Compound Report.

3 (optional) Wählen Sie eine andere 
Verbindungsberichtsvorlage aus.

a Klicken Sie im Fenster Method 
Explorer auf Reports > Common 
Reporting Options.

b Wählen Sie CompoundReport
WithIdentificationHits.xlsx als 
Verbindungsberichtsvorlage aus.

• In der Software sind verschiedene 
Berichtsvorlagen enthalten.

• Berichtsvorlagen können mit Excel 
und dem Report Designer-Add-in 
angepasst werden.

Abb. 56 Bereich Common Reporting Options im Method Editor

Aufgabe 22. Verbindungsbericht drucken

Schritt Ausführliche Anweisungen Anmerkungen

Das Kontrollkästchen Overlay 
compound chromatograms sollte für 
GC/Q-TOF-Daten deaktiviert werden.

Alle Vorlagen mit der 
Dateierweiterung XLTX können 
mit Excel und dem Report 
Designer-Add-in angepasst 
werden. Der 
Erfassungsmethodenbericht kann 
nicht angepasst werden.
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4 Drucken Sie den Bericht. a Klicken Sie auf File > Print > 
Compound Report oder auf den Pfeil 
im Symbol Print Analysis Report , 
und wählen Sie dann Print Compound 
Report, um den Verbindungsbericht zu 
drucken.

b Aktivieren Sie das Kontrollkästchen 
Print preview.

c Klicken Sie auf OK. Überprüfen Sie den 
Bericht.

d Klicken Sie auf das Symbol Close Print 
Preview.

• Im Dialogfeld Print Compound 
Report können Sie einen anderen 
Drucker auswählen und festlegen, 
dass der Bericht in einer PDF- oder 
Excel-Datei gespeichert werden 
soll. Außerdem können Sie hier 
auswählen, ob alle oder nur die 
markierten Ergebnisse gedruckt 
werden sollen und ob verschiedene 
Datendateien in einem Bericht 
kombiniert werden sollen.

• Weitere Informationen finden Sie in 
der Online-Hilfe oder auf der Report 
Designer-Schulungs-DVD.

Abb. 57 Fenster Print Preview mit Verbindungsbericht

5 Schließen Sie die Datendatei, ohne 
die Ergebnisse zu speichern.

a Klicken Sie auf File > Close Data File.
b Wenn Sie zum Speichern der 

Ergebnisse aufgefordert werden, 
klicken Sie auf No.

Aufgabe 22. Verbindungsbericht drucken

Schritt Ausführliche Anweisungen Anmerkungen
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Aufgabe 22. Verbindungsbericht drucken
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4
Arbeiten mit Fenstern
Arbeiten mit Fenstern

Wenn Sie das Programm Qualitative Analyse erstmals öffnen, werden im 
Standardlayout vier Fenster angezeigt: Data Navigator, Method Explorer, 
Chromatogram Results und MS Spectrum Results. Sie können zwischen der 
Navigator View und der Compound Details View umschalten.

Über das Menü „View“ können Sie in der Navigator View siebzehn weitere 
Fenster einblenden: 

• Method Editor – ermöglicht Ihnen das Bearbeiten von 
Methodenparametern, unterteilt in verschiedene Registerkarten

• Spectrum Preview – ermöglicht Ihnen das schnelle Scannen der Spektren in 
einer Datendatei

• MS Spectrum Results – zeigt die MS- und MS/MS-Spektren an

• Difference Results – zeigt die Differenzergebnisse nach einer 
Bibliothekssuche an

• Deconvolution Results – zeigt die dekonvolutierten Spektren an

• Deconvolution Mirror Plot – zeigt zwei dekonvolutierte Spektren in einem 
Spiegelbild an

• UV Spectrum Results – zeigt die UV-Spektren an – nur verfügbar für 
LC/MS-Daten

• Integration Peak List – zeigt die Integrationsergebnisse in einer Tabelle an

• MS Spectrum Peak List 1 – zeigt die Peak-Tabelle für das erste ausgewählte 
Spektrum an

• MS Spectrum Peak List 2 – zeigt die Peak-Tabelle für das zweite 
ausgewählte Spektrum an

• MS Actuals – zeigt Erfassungsinformationen für das markierte Spektrum an

• Compound List – zeigt die Verbindungen an, die über einen der Find 
Compounds-Algorithmen gefunden werden

• Compound Identification Results – zeigt die Identifikationsinformationen 
für die ausgewählte Verbindung an

• Spectrum Identification Results – zeigt die Identifikationsinformationen für 
die ausgewählten Spektren an

• MS/MS Formula Details – zeigt eine Tabelle mit möglichen Formeln an, die 
für die in einem MS/MS-Spektrum erkannten Fragmente berechnet werden
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• Structure Viewer – zeigt die mit der aktuellen Verbindung oder den 
aktuellen Spektren verbundene Struktur an

• Sample Information – zeigt Informationen über die markierte Datendatei an

• Sequence Editor – ermöglicht Ihnen die Bearbeitung einer 
Methodensequenz

Ferner können Sie drei Toolfenster anzeigen, die beim Starten des jeweiligen 
Tools eingeblendet werden:

• Formula Calculator

• Mass Calculator

• Recalibrate

Fenstersymbole in der Hauptsymbolleiste

Mit diesen Symbolen in der Hauptsymbolleiste werden die Fenster geöffnet und 
geschlossen. Zusätzliche Symbole sind verfügbar, wenn die MassHunter 
BioConfirm-Software installiert wird. Befehle im Menü „View“ können ebenfalls 
zum Öffnen dieser Fenster verwendet werden.
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MS Spectrum
Results

Data Navigator

Spectrum 
Preview

Chromatogram Results

Method Editor

Method Explorer

Integration Peak List

Spectrum 
Identification 
Results

MS Spectrum 
Peak List 1

Compound List

MS Spectrum 
Peak List 2

MS Actuals

Compound 
Identification 
Results

Sequence 
Editor

Deconvolution
Results

UV Spectrum 
Results

MS/MS 
Formula 
Details

Difference 
Results

Structure 
Viewer

Sample 
Information

Deconvolution
Mirror Plot
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Arbeiten mit Ergebnisdaten im Data Navigator

Das Fenster „Data Navigator“ und zugehörige Tools

Der Data Navigator organisiert alle Ergebnisse der Extraktion und 
Spektrumauswahl entweder nach Datendatei oder nach Datentyp.

 

Ist dieses Symbol aktiviert (Standardeinstellung), 
werden durch Markierung eines Chromatogramms 
im Data Navigator auch die zugehörigen Spektren 
markiert. Die entsprechenden Grafikergebnisse für 
Chromatogramm und Spektrum werden ebenfalls 
hervorgehoben. Die verknüpfte Navigation 
funktioniert nur, wenn Sie den Menüeintrag 
„Integrate and Extract Peak Spectra“ im Menü 
„Chromatograms“ verwendet oder einen der 
Compounds-Algorithmen ausgeführt haben.

Einzelnes Häkchen – Aktiviert die 
Kontrollkästchen aller markierten Daten.

Zwei Häkchen, eines davon grau – Aktiviert die 
Kontrollkästchen markierter Daten und deaktiviert 
die übrigen Kontrollkästchen.

Zwei Häkchen – Aktiviert alle Kontrollkästchen.

Chromatogramme und Spektren werden 
angezeigt, wenn die entsprechenden 
Kontrollkästchen aktiviert sind.

Aktivierungstools

Symbol „Verknüpfte Navigation“
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Durchführen von Operationen am Chromatogramm

Sie können am gesamten Chromatogramm oder an einem ausgewählten Bereich des 
Chromatogramms mit diesen Menüeinträgen folgende Operationen durchführen:

Aktion Menüeintrag

Peak-Beschriftungen im Chromatogramm 
ändern

Configuration > Chromatogram Display Options

Ein Chromatogramm extrahieren Chromatograms > Extract Chromatograms

Definierte Chromatogramme extrahieren Chromatograms > Extract Defined Chromatograms

Das Chromatogramm integrieren Chromatograms > Integrate Chromatogram

Peak-Spektren integrieren und extrahieren Chromatograms > Integrate and Extract Peak Spectra

Peak-Spektren integrieren und 
dekonvolutieren

Chromatograms > Integrate and Deconvolute Peak 
Spectra

Das Chromatogramm glätten Chromatograms > Smooth Chromatogram

Ein beliebiges Chromatogramm 
subtrahieren

Chromatograms > Subtract Any Chromatogram

Das Signal-Rausch-Verhältnis berechnen Chromatograms > Calculate Signal-to-Noise

Verbindungen nach automatischen 
MS/MS-Daten suchen

Find > Find Compounds by Auto MS/MS

Verbindungen nach MS/MS-Zieldaten 
suchen

Find > Find Compounds by Targeted MS/MS

Verbindungen für MS(1)-Daten suchen Find > Find Compounds by Molecular Feature

Verbindungen für GC/MS-Daten suchen Find > Find Compounds by Chromatogram 
Deconvolution

Verbindungen für MRM-Daten suchen Find > Find Compounds by MRM

Verbindungen nach 
Integrationsergebnissen suchen

Find > Find Compounds by Integration

Verbindungen suchen, die bestimmten 
Formeln entsprechen

Find > Find Compounds by Formula
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Auswählen von Bereichsoperationen aus dem Kontextmenü

Wenn Sie einen chromatografischen Bereich ausgewählt haben, können Sie 
zusätzlich zu den oben erwähnten und noch weiteren Operationen auch ein 
Spektrum extrahieren und ein Spektrum in den Hintergrund extrahieren.

1 Klicken Sie zum Durchführen dieser Operationen in der Symbolleiste 
„Chromatogram Results“ auf das Tool „Range Select“ ( ). 

2 Klicken Sie auf die Stelle, an der der Bereich beginnen soll, ziehen Sie den 
Cursor über einen Bereich, und lassen Sie die Maustaste los.

3 Klicken Sie mit der rechten Maustaste auf eine beliebige Stelle im 
Chromatogramm, und klicken Sie im Kontextmenü auf die Operation.

Speichern von Ergebnissen in Datendateien

• Klicken Sie auf das Symbol Save ( ), oder klicken Sie auf File > Save Results.

Beim Beenden des Programms werden Sie ebenfalls gefragt, ob Sie die 
Ergebnisse in der Datendatei speichern möchten, sofern Sie diese Funktion 
nicht deaktiviert haben. (Die Funktion kann über das Dialogfeld „Message Box 
Options“ deaktiviert werden.)

Durchführen von Operationen an einem MS- oder MS/MS-Spektrum

Mit diesen Menüeinträgen können Sie die folgenden Operationen an einem MS- 
oder MS/MS-Spektrum oder an einem ausgewählten Bereich eines MS- oder 
MS/MS-Spektrums durchführen:

Aktion Menüeintrag

m/z, Isotopenhäufigkeit, Ladungsstatus 
und weitere Informationen über Peaks in 
einem Spektrum anzeigen

View > MS Spectrum Peak List 1

Peak-Beschriftungen in einem Spektrum 
ändern

Configuration > MS and MS/MS Spectra Display 
Options

Das Hintergrundspektrum subtrahieren Spectra > Subtract Background Spectrum

Ein beliebiges Spektrum subtrahieren Spectra > Subtract Any Spectrum (und dann auf ein 
weiteres Spektrum klicken)

Zwei Spektren addieren Spectra > Add Any Spectrum (und dann auf ein 
weiteres Spektrum klicken)
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Arbeiten mit chromatografischen visuellen Daten

Das Fenster „Chromatogram Results“

Eine Datenbank nach Einträgen 
durchsuchen, die bestimmten Massen in 
einem Spektrum entsprechen

Spectra > Search Database for Spectrum Peaks

Formeln für die Massen im ausgewählten 
Bereich eines Spektrums generieren 

Spectra > Generate Formulas from Spectrum Peaks 
(wenn ein Bereich im MS-Spektrum ausgewählt ist)

Dekonvolutieren anhand des Resolved 
Isotope-Algorithmus

Spectra > Deconvolute (Resolved Isotope)

Bibliothek durchsuchen Identify > Search Library for Spectra oder
Spectra > Search Library for Spectra

Aktion Menüeintrag
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Chromatogrammergebnis-Tools

Zoomtools in ihrer 
Reihenfolge

Auswahltools in ihrer 
Reihenfolge Range Select – Ist dieses Tool aktiviert, können Sie einen 

Bereich für ein Chromatogramm auswählen, an dem Sie 
Aktionen durchführen können.

Peak Select – Ist dieses Tool aktiviert, können Sie ein 
Spektrum eines integrierten Peaks am Scheitelpunkt 
auswählen.

Manual Integration – Ist dieses Tool aktiviert, können Sie 
eine interaktive Integration durchführen.

Walk Chromatogram – Ist dieses Tool aktiviert, können 
Sie einzelne Spektren anzeigen, indem Sie auf die 
einzelnen Punkte klicken oder die linke und rechte 
Pfeiltaste auf der Tastatur verwenden.

Annotation – Ist dieses Tool aktiviert, können Sie den 
Chromatogrammen Bild- und Textanmerkungen 
hinzufügen.

Autoscale X-axis and Y-axis

Autoscale X-axis

Autoscale Y-axis

Unzoom

Autoscale Y-axis during Zoom

Linked Y-Axis-Modus

Eines dieser Tools muss 
immer ausgewählt sein.
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Arbeiten mit visuellen Spektrumdaten

Das Fenster „MS Spectrum Results“

MS-Spektrumergebnis-Tools

Zoomtools in ihrer 
Reihenfolge

Auswahltools in ihrer 
Reihenfolge

Range Select – Ist dieses Tool aktiviert, können Sie einen 
Bereich für ein Chromatogramm auswählen, an dem Sie 
Aktionen durchführen können.

Annotation – Ist dieses Tool aktiviert, können Sie den 
Chromatogrammen Bild- und Textanmerkungen hinzufügen.

Calipers – Ist dieses Tool aktiviert, können Sie dem 
ausgewählten Spektrum einen Deltamassen-Messschieber 
hinzufügen. Im Fenster „Deconvolution Results“ können Sie 
zudem einen Aminosäuren-Messschieber oder einen 
Modifikationsmessschieber hinzufügen. Weitere 
Informationen finden Sie in der Online-Hilfe.

Autoscale X-axis and Y-axis

Autoscale X-axis

Autoscale Y-axis

Unzoom

Autoscale Y-axis during Zoom

Linked Y-Axis-Modus

Zum Aufheben einer 
Toolauswahl klicken 
Sie auf ein anderes 
Tool oder Symbol.
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Arbeitsabläufe

Mit Arbeitsabläufen können Sie die Benutzeroberfläche für Ihre Anwendung 
anpassen. Jeder Arbeitsablauf lädt eine andere Methode mit den für diesen 
Arbeitsablauf geeigneten Parametern. Außerdem lädt jeder Arbeitsablauf ein 
anderes Layout; zu diesen Layouts gehört die Anpassung der in den einzelnen 
Tabellen aufgeführten Spalten. In vier der Layouts wird außerdem ein 
besonderer Method Editor-Abschnitt hinzugefügt, der Kopien der Abschnitte 
im Method Editor enthält, die für den jeweiligen Arbeitsablauf wichtig sind. 
Durch das Gruppieren der Funktionen, die in einem bestimmten Arbeitsablauf 
verwendet werden, können Sie Ihre Methode einfacher anpassen.

Mehrere verschiedene Arbeitsabläufe stehen im Programm zur qualitativen 
Analyse zur Verfügung. Diese sind:

• General

• BioConfirm – Diese Arbeitsabläufe sind nur dann verfügbar, wenn die 
BioConfirm-Software installiert und im Dialogfeld „User Interface 
Configuration“ markiert ist. BioConfirm umfasst mehrere mögliche 
Arbeitsabläufe, je nach Art der Analyse, die Sie durchführen möchten. 
BioConfirm wird mit LC/MS-Datendateien verwendet.

• Chromatogram Peak Survey

• Formula Confirmation and Sample Purity

• MS Target Compound Screening

• GC/Q-TOF Compound Screening

Wenn Sie mit GC/MS-Daten arbeiten, können Sie den Arbeitsablauf „General“ 
oder den Arbeitsablauf „GC/Q-TOF Compound Screening“ auswählen. Wenn 
Sie mit LC/MS-Daten arbeiten, können Sie einen beliebigen Arbeitsablauf 
außer „GC/Q-TOF Compound Screening“ auswählen.

Spezifische Methode

Jeder Arbeitsablauf lädt eine spezifische Standardmethode mit den 
entsprechenden Einstellungen für den jeweiligen Arbeitsablauf. Wenn Sie 
beispielsweise zu einem der BioConfirm-Arbeitsabläufe wechseln, wird der 
Target data type für den Algorithmus „Find Compounds by Molecular 
Feature“ auf Large molecules (proteins, oligos) gesetzt. Diese Einstellung 
eignet sich für den BioConfirm-Arbeitsablauf, jedoch nicht standardmäßig für 
die übrigen Arbeitsabläufe.
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Spezifisches Layout

Zusätzlich lädt jeder Arbeitsablauf ein spezifisches Layout. Ein Layout besteht 
aus folgenden Elementen:

• Position und Größe der einzelnen Fenster

• Welche Fenster Registerkarten aufweisen

• Welche Fenster frei beweglich sind

• Welches Registerkartenfenster sich oben befindet

• Welche Fenster standardmäßig sichtbar sind

• Ob die Statusleiste angezeigt wird

Für jedes Plotfenster („Chromatogram Results“, „Spectrum Preview“, 
„MS Spectrum Results“, „Deconvolution“ und „UV Results“) werden folgende 
Einstellungen gespeichert:

• Ob die Grafiken sich überlagern

• Ob der Modus „Autoscale Y-Axis during Zoom“ aktiviert ist

• Ob der Modus „Linked Y-Axis“ aktiviert ist

Für jedes Tabellenfenster werden folgende Einstellungen gespeichert

• Sichtbare Spalten

• Reihenfolge der Spalten

• Breite der einzelnen Spalten

• Alle der Tabelle hinzugefügten Filter (nur verfügbar für die Tabellen 
„Compound List“ und „Compound Identification Results“ sowie das Fenster 
„Spectrum Identification Results“).

Spezifischer Abschnitt im Method Explorer und Method Editor

Durch die Verwendung des Method Editors mit dem Arbeitsablauf „General“ 
können Sie nahezu alle Parameter in der Methode ändern. 

Durch jeden der vier übrigen Arbeitsabläufe werden die im Method Explorer 
verfügbaren Abschnitte geändert. Jeder neue Abschnitt enthält nur diejenigen 
Method Editor-Registerkarten und -Abschnitte, die für den jeweiligen 
Arbeitsablauf relevant sind. Durch das Ändern eines Parameters im 
Arbeitsablaufabschnitt wird auch der Parameter im entsprechenden Abschnitt 
in den allgemeinen Method Editor-Abschnitten geändert.
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Zwei Registerkarten werden in den allgemeinen Method Editor-Abschnitten 
nicht wiederholt. Der Abschnitt Chromatogram Peak Survey Workflow > 
Spectrum Peak Identification und die Registerkarte Chromatogram Peak 
Survey Workflow > Chromatogram Extraction > Chromatograms sind nur 
im Arbeitsablauf „Chromatogram Peak Survey“ enthalten. Diese Abschnitte 
wirken sich nur auf den Algorithmus „Chromatogram Peak Survey“ aus. Dieser 
Algorithmus wird nur in diesem Arbeitsablauf verwendet sowie in der Aktion 
Chromatogram Peak Survey without Report und in der Aktion 
Chromatogram Peak Survey with Analysis Report.

Arbeitsablaufmethoden und -layouts

Zusätzliche Standardmethoden und -layouts werden für die einzelnen 
Arbeitsabläufe bereitgestellt. 

Arbeitsablauf Methode Layout Method Editor-Abschnitt

General default.m Default.xml Kein

BioConfirm Intact 
Protein

BioConfirm
IntactProtein-
Default.m

BioConfirm-
IntactProtein-
MaximumEntropy-
Default.xml

BioConfirm Workflow

BioConfirm High 
Mass Intact Protein

BioConfirm
IntactProtein
HighMass
Default.m

BioConfirm
IntactProtein
LMFE.xml

BioConfirm Workflow

BioConfirm Small 
Oligonucleotides

BioConfirmOligo
nucleotideSmall.m

BioConfirmOligo-
nucleotide.xml

BioConfirm Workflow

BioConfirm Large 
Oligonucleotides

BioConfirmOligo
nucleotideLarge-
Default.m

BioConfirmOligo-
nucleotide.xml

BioConfirm Workflow

BioConfirm Protein 
Digest

BioConfirmProtein
Digest-Default.m

BioConfirm
ProteinDigest.xml

BioConfirm Workflow

BioConfirm 
Synthetic Peptide

BioConfirmSynthetic
Peptide-Default.m

BioConfirm
SyntheticPeptide.xml

BioConfirm Workflow

Chromatogram Peak 
Survey

ChromPeakSurvey-
Default.m

Default.xml Chromatogram Peak 
Survey Workflow
Agilent MassHunter Workstation Software - Handbuch zur Einarbeitung in die qualitative Analyse für LC/MS 111



4
Arbeitsabläufe
Formula 
Confirmation and 
Sample Purity

SamplePurity-
Default.m

SamplePurity-
Default.xml

Formula Confirmation and 
Sample Purity Workflow

MS Target 
Compound 
Screening

Screening-Default.m Screening-Default.xml MS Target Compound 
Screening Workflow

GC Q-TOF 
Compound 
Screening

GC_Q-TOF.m QTOFData.xml GC/Q-TOF Compound 
Screening

Arbeitsablauf Methode Layout Method Editor-Abschnitt
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Anpassen einer Reportvorlage

Detaillierte Informationen zum Ändern einer Reportvorlage finden Sie 
entweder in der Online-Hilfe für das Add-In „MassHunter Report Designer“, im 
Einarbeitungshandbuch für den Report Designer oder auf der Schulungs-DVD 
zur Reporterstellung. Die folgenden Schritte geben Ihnen einen kurzen 
Einblick in die Auswirkungen der Anpassung einer Vorlage.

1 Wechseln Sie zu dem Ordner mit den Reportvorlagen. Standardmäßig handelt 
es sich um folgenden Ordner: 
\MassHunter\Report Templates\Qual\B.05.00\en-US\Letter. Im Method Explorer 
auf der Registerkarte „General > Common Reporting Options > Templates“ 
können Sie einen anderen Ordner auswählen.

2 Erstellen Sie eine Kopie der Vorlage, die Sie ändern möchten. Klicken Sie mit der 
rechten Maustaste auf die Kopie, und klicken Sie auf Eigenschaften. Deaktivieren 
Sie ggf. das Kontrollkästchen Schreibgeschützt. Klicken Sie anschließend mit der 
rechten Maustaste auf die Kopie, und klicken Sie im Kontextmenü auf Öffnen.

Indem Sie die Vorlage auf diese Weise öffnen, teilen Sie Excel mit, dass es sich 
um eine Vorlagendatei handelt. Ist die Vorlage geöffnet, können Sie die Kopf- 
und Fußzeilen ändern und Parameterspalten hinzufügen, entfernen oder 
verschieben. Weitere Informationen finden Sie in der Online-Hilfe. Alle 
Vorlagen zur qualitativen Analyse sind schreibgeschützt. Sie ändern diese 
Eigenschaft, bevor Sie eine Vorlage bearbeiten.
Agilent MassHunter Workstation Software - Handbuch zur Einarbeitung in die qualitative Analyse für LC/MS 113



4
Anpassen einer Reportvorlage
Viele Vorlagen werden mit dem Programm zur qualitativen Analyse 
installiert. In der Online-Hilfe zur qualitativen Analyse finden Sie weitere 
Informationen zum Inhalt der einzelnen Reportvorlagen.

3 Nehmen Sie die gewünschten Änderungen vor.

Weitere Informationen zum Bearbeiten einer Vorlage finden Sie entweder in 
der Online-Hilfe für das Add-In „MassHunter Report Designer“ oder auf der 
Agilent MassHunter Reporting - Training DVD.

4 Klicken Sie zum Speichern der neuen Vorlage entweder auf Speichern, oder 
klicken Sie über die Microsoft Office-Schaltfläche auf Speichern unter > 
Andere Formate. 

5 Geben Sie einen aussagekräftigen Namen ein, und klicken Sie auf Speichern.
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